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1 Foreword

This standard describes the requirements and procedures for the Three Dimensional Technical Data
Package (3D/TDP) solid model repository established and maintained by PAM-MTV. The 3D/TDP is
based on Creo Parametric Mechanical Design Automation software for the purpose of Computer Aided
Design (CAD). The 3D/TDP uses Windchill PDMLink Product Data Management (PDM) software

for data management and storage. Creo Parametric and Windchill PDMLink are both products of PTC.

All contractors and government personnel working with models contained within the 3D/TDP system
shall follow the requirements of this standard regarding both Creo Parametric and Windchill
PDMLink. Documents that are not solid model related but which normally comprise a TDP such as
packaging sheets, quality assurance provisions, electrical schematics, etc. shall be stored in Windchill
PDMLink.

1.1 Background

In order to take advantage of available technologies, PAM-MTV has been maintaining the
technical data system including 3D solid models. The intent is to develop, maintain, and provide these
3D/TDPs throughout the lifecycle of the item. 3D/TDPs will be used for development, production, life
cycle management, configuration management, logistics support, and all other purposes that would
normally use technical data. The 3D based system will have the following advantages:

e Automated generation and update of line drawings

e Automated Bills Of Material (BOM)

e Infinite viewpoints and exploded views of assemblies
e Rapid prototyping

e Faster design updates

e Improved logistics support

e Improved system interface analysis

e Better and faster engineering analysis capabilities (kinematic, dynamic, and structural analysis,
tooling design, etc.)

e Reduced TDP interpretation errors

In order to use solid models as a basis for the technical data it is important that the solid models
be built to a set of common standards, using sound modeling practices, and be fully defined.

Performing cosmetic modeling (in which a model looks like it is supposed to but is actually
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dimensionally incorrect), may be faster and easier; however, as a basis for product definition is

inadequate.

Appendix D.5 Checklists referenced within this standard, defines required criteria for promotion
approval to the Released state. Any requirements made by this standard must be met, whether or not

they are cited on the checklist.

The FMTV PDMLink User Guide document, referenced within this standard, defines procedures to be
followed when using Windchill PDML.ink in conjuncture with the 3D/TDP effort.
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2 Configuration Management Representations

2.1 Standards Application
The requirements of this specification apply to all objects, parts, assemblies, and/or drawings that are
submitted through the formal release process via Windchill Change Notice from In Work to Released.

2.2 Drawings Required

All parts and assemblies promoted to Released shall have associated, fully defined 2D drawings or a
PDF copy of the latest (requires prior TACOM approval for PDF). Only the models/drawings
representing the latest design configuration (i.e., the latest revision drawing plus any outstanding
ECPs) shall be promoted through the release process. This does not apply to Standard Parts, which are

defined in Appendix F.

2.3 Engineering Changes
Models/drawings shall be changed via approved Engineering Change Proposals (ECPs) only. ECPs
shall conform to MIL-STD-3046.

2.4  Configuration Management

When 3D/TDP associated 2D drawing are released in the database, that drawing becomes the master
for configuration management purposes (i.e. drawings will not be input into the 3D/TDP and
concurrently maintained in another CAD format) Refer to MIL-STD-3046 for complete

Configuration Management standards.

2.5 Products
The Product in Windchill PDMLink for the FMTV 3D solid modeling TDP will provide enough detail

for files to be checked into the database in the appropriate location.
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2.6 Object Status

The user making changes on a drawing, part, assembly, or other object for release in the FMTV
database shall set the Commonspace status to Checked Out while change is in progress. The status

should be applied when the drawings are identified for the ECP.

2.7 Security

This system security falls under the Windchill system security settings.

2.8 Revision Scheme

The initial release of drawings, parts and assemblies will be the B revision level. Subsequent changes
will be from a one to three digit alphabetic character (not including letters [1],[0],[Q], [S], [X], or
(i.e., [A, BL[C,... AAL [AB] [AC, ... [YYV], Y YW, [YYY]) Refer to ASME Y14.35M for further

information about Revision Scheme.

2.8.1 The part or assembly revision scheme is dependent to its associated drawing and vice

versa. The Creo Parametric drawing, and model revision shall be the same for FMTV

drawings/models. All changes to model and drawing will follow formal ECP procedures.

2.8.2 The revision of the drawing shall be displayed on all drawing sheets in accordance with

the current acceptable drawing format. As new revisions of the models and drawings are

created the next higher revision will be used for the current drawing.

2.9 Promotion

Drawings submitted for promotion shall follow instructions found in FMTV PDMLink User Guide.

2.10 Quality Assurance

All parts, assemblies, and drawings submitted for promotion shall be checked in accordance with
Appendix D.5 Checkilists.
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2.10.1 All Creo Parametric objects promoted to Released are required to pass the FMTV

ModelCHECK process.

2.11 Release Level Flowchart
The following flowchart illustrates the FMTV release scheme using the ECP2 or ERR process in

Windchill PDMLink.

Approwed
ECP2 Implementation ECP Review Approy ed ERR Approval Released
Process /\C) m
Resulting Drawing added at Creation
NOR Add Drawing Resolved )
and Complete ] Wiait for NORs to Resolve

Task
From To Resolved
DWG DWG
Rev A Rev B

FIGURE 1: ECP2 RELEASE LEVEL FLOWCHART

2.12 Notice of Revision
The Notice of Revision (NOR) document shall be a redline markup of the previous revision of the
drawing. If the drawing is an Initial Release drawing, the NOR is not required. The redline NOR is

submitted and stored with the ECP document.
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3 Part Modeling Standards

3.1 Part Modeling Practice

3.1.1 Parts should be functional and created in a logical sequence. Features should be simple
and be created such that they are easily modifiable by another user. Parts shall have every
feature that the real part is required to have. For example, plastic parts should contain every
draft angle and radii detail expected on the real part. If text (e.g. part number) is stamped or
molded into a part, that should also be modeled. Parts should be able to stand on their own

without reference to other parts or assemblies.

3.1.1.1 If the part is a source controlled drawing or vendor item control drawing, CAD

Files from the vendor will be requested. If the CAD file is unavailable, all interface and
envelope dimensions shown on the drawing shall be modeled. The part shall be

modeled in Creo Parametric.

3.1.2.1 For Creo Parametric conversion efforts, features will be created using the
existing dimensioning scheme contained in the drawings or other appropriate source.
All changes to the drawing shall be documented by the NOR/ECP.

3.1.2.2 For new parts and design changes, features will be created in a logical manner
in which the dimensioning scheme for the new part will be shown with no created

dimensions on the drawing (unless required).

3.1.3 All models shall regenerate successfully with all features in the unsuppressed state.
When parts are modified, the next higher assembly shall also be capable of being successfully

regenerated.

3.1.4 The latest FMTV_START_PART or FMTV_START_SHTML _PART shall be used for

part creation.
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3.1.5 Sheetmetal parts shall be created with the Creo Parametric Sheetmetal module.

3.1.6 All routed tubing or piping models and assemblies shall be created using the Creo Piping
and Cabling Extension.
3.1.7 All wiring and cabling models and assemblies shall be created using a combination of

Creo Piping and Cabling Extension.

3.2 Tolerances
All dimensions shall include tolerances as required to be shown appropriately on the drawing. When
geometric tolerances, geometric tolerance datums, inspection dimensions, datum targets, and/or basic

dimensions are required, these shall be set in the model using the appropriate GTOL commands.

3.3 Materials

Materials shall be identified on the part in two locations:

1. The materials section under Model Properties in Creo Parametric. Material file creation shall
be requested from the custodian of the material file library for any material required that is not
in the current library.

2. In the materials note section of the 3D notes which are applied to the drawing.

3. The material file used on the part shall match the material called out in the notes (for example:
ASTM A36 material file shall be used over a generic STEEL material file)

3.4 Surface Finishes

Surface finishes shall be shown on the part as required.

3.5 Model Notes
Sufficient model notes shall be used to describe the part and part features.  If notes are intended to
apply to specific features, they shall be attached to those features. Notes found in the FMTYV start parts

include:
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a. Distribution_Note: The drawing distribution statement shall be included in a 3D note called
Distribution_Note.

b. Proprietary_Note: If a proprietary legend is required on the drawing, this legend shall be
entered on the model as a 3D note entitled Proprietary Note.

c. Export Control Note: The drawing export control warning note shall be included in a 3D note
called Export_Control_Note

d. Notel: Notel shall contain the current drawing standards.

e. Note2 — Note#: These notes shall be used to describe the model as required for the drawing.

f. DRW_NOTE: This note is a summary of all the Notel-Note# for display on 2D Parametric
drawing.

g. NoteO_DESIGN_INTENT: Note0 DESIGN_INTENT shall be used to document design
intent. Design intent is any optional information the designer thinks is valuable to those who

might view the model at some future point. An example of a design intent note is as follows:

THIS PART IS MADE OF ALUMINUM 7075-T6. CARBON STEEL WAS TESTED BUT
CORRODED DURING USE. USE OF STAINLESS WAS CONSIDERED BUT NOT PURSUED
DUE TO TIME CONSTRAINTS.

3.6 Relations
Relations shall have no errors upon regeneration. Relations found in feature CSO and ACSO of the

FMTYV start models are required.

3.7 Default Datums

All parts will start with default datum planes and a default coordinate system identical to those found
in the FMTYV start models. The default datum planes shall be named FRONT, TOP, and SIDE. The
coordinate system shall be named CSO with its orientation as follows; Z axis is elevation, X axis is

along the length of the vehicle, Y axis across the vehicle width.

3.8 Part File Names

Parts shall be named using the following convention:
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CAGE_PartNumber.prt i.e. 19207_8448510.prt

If the model requires an extension (or suffix) it will follow the convention described in Table 1 -

Model Name Suffix Usage.

Suffix Range Description

-001 -399 Fully detailed down level parts on a drawing.
Down-Level detailed parts that are part of weldment that are the same

1100 150 base number of the weldment assembly. (Note: This is an overlap for
the -001 thru -399, but the down-level weldment parts are to start at -
100. Fully detailed parts are still allowed to use -100 thru -150).

-400 -499 Parts modified in the field for the application of a kit.

-500 -599 Non-detailed down level parts on a drawing.

-5000 - Top Level 87T — Used for Large Assemblies

-600 -699 Routed systems models (cabling, piping, etc...)

-6000 -6999 Overflow for routed systems models (cabling, piping, etc...) if more
than the original -600 through -699 are required

-700 -799 | Simulation models (as well as the extension _FEA)

-800 -899 Backdrop Parts / Assemblies
Overflow or for miscellaneous (deformed, die, shrinkwrap parts, etc.)

-900 -998 Deformed parts may also use the _def naming convention. Same intent
for dies and shrinkwraps.

29000 29999 Overflow or.mlscellaneous parts if more than the original -900 through -
998 are required.

-999 or -gen Non-useful generic components used in Family Tables.
_skel Skeleton Models
-opt, -oc Optional Configuration (either is acceptable)
-cast Use for castings when a casting is an Alternate Design
TaABLE 1: MODEL NAME SUFFIX USAGE
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3.8.1 Hardware File Names
Hardware naming convention shall generally start with -001 and is not required to follow
Section 3.8.

3.8.2 Exceptions
- Refer to Section 7 - Electrical for naming convention on Schematics and Electrical related
components.

- Refer to Section 8 - Piping for naming convention for Piping Assemblies.

3.9 Model Views

All models shall have separately named views defining the TOP_VIEW, BOTTOM_VIEW,
LEFT_VIEW, RIGHT_VIEW, BACK_VIEW, FRONT_VIEW, and DEFAULT views. These views
exist in the FMTYV start part. The FRONT view is oriented facing the yellow (or primary) side of the
FRONT datum plane, with the yellow side of the TOP datum plane facing up. The remaining
orthogonal views follow standard third angle projection practice. Current drawing models should be

created such that the named views correspond to the existing drawing views.

3.10 Deformed Parts

Deformed parts will have to be handled on a case to case basis. If a part can be deformed in
numerous shapes (rivets), then use the non-deformed part. This makes it easier, rather than having
100+ deformed parts. In addition, Flexible Components shall ALWAYS be considered first and is

preferred over a deformed part. This will help keep the data management aspect to a minimum.
3.10.1 Naming Convention for Deformed Parts

Only use the non-deformed part’s part number with the extension starting with a -9xx. Also, -
9xxx can be used if there are numerous instances of the deformed parts. Do not use the top assembly

name with -900 as was previously used.
3.10.2 When to use Deformed Parts

1. Create a deformed part if it will only be needed on a particular drawing. (Examples are
lanyards, cables, etc).

2. Create a deformed part if the non-deformed part causes a major interference.
3. Create a deformed part if the non-deformed part will not work in any way possible.
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3.10.3 Creating Deformed Parts from Tabulated Parts

If a deformed part is made from a tabulated part, keep the tabulation and add the -900 extension
after. (Ex: 19207_12345678-001 will be 19207 _12345678-001-900 when it is deformed).

3.10.4 Creating Deformed Parts with Flexible Components

The preferred option when creating deformed parts is using flexible component functionality.
Flexible components allow the model to be represented in different states within different assemblies.
Flexible components shall always be looked at first for any deformed part/assembly. An example of
this is if a drawing of a spring requires it to be modeled in its free state but when it needs to be
assembled it must be represented in its compressed state. With flexible component functionality it
would not require that a second model to be created. It allows the designer to vary dimensions,

parameters, resume or suppress features (or components if flexible component is a sub-assembly).

3.10.5 Promoting Deformed Parts

When promoting a deformed part, promote it with the assembly where the deformed part is
used. Keep the deformed part at the same revision level of the most current non-deformed part in
Windchill PDMLink database. Also, remember to relate all deformed parts back to the non-deformed
parts drawing while the drawing is being updated. If the deformed part is just being used on a next
higher assembly, it shall be related back to the deformed parts drawing the next time the drawing is
revised. When a previously released deformed part is required to be changed in an ECP due to other
changes that affect said part and the base part is not part of that ECP, either a new flexible model state
or a standalone model shall be created with another -9xx extension. The new model shall have the

same revision as the base number.

3.11 Layers
The following layers shall be used in part mode (these exist in the FMTV start part). Other layers may
be added as needed, for example, a datum required on a drawing may be placed on a separate layer so

that it can stay on while the other datums are layered off.
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Layer name Layer Assignments gg’?e i
DTM_AXES All datum axes Hide
DTM_CSYS All datum coordinate systems Hide
DTM_CURVES All curve features Hide
DTM_PLANES All datum plane features Hide
DTM_POINTS All datum point features Hide
G_DTM_PLANES All geometric tolerance datum planes Hide
ITEM_ID Only the cosmetic/curve feature describing the part identification number | Hide
NOTES All part notes Hide
SURFACES All surface features and quilts Hide
THREADS All cosmetic and actual threads Hide
XSEC_DATUMS All cross-section datums Hide

TABLE 2: PART LAYERS

3.12 Part Parameters

The following parameters are required when entering a part or assembly into the 3D/TDP Product

Release Process. Required items are noted in the Input column.

Items in italics are no longer required to be filled out, but will remain for legacy drawings. Windchill

PDMLink will manage these parameters.

Parameter Name Parameter Description Format Example | Input
01* | AGENCY Agency or service US ARMY *
02 | CAGE_CODE Original design activity CAGE code 19207 REQ
03 | CATALOG_NOMENCLATURE Nomenclature assigned by supply SPRING, HELICAL
04 | CHECKER_NAME Person that checked the original drawing K.BALL REQ
05 | CONTRACT_NUMBER Contract #-original design contract DAAE20-03-C-S023 REQ
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. . Tank Automotive &

* *
06* | DESIGN_ACTIVITY Design activity Armaments Command REQ
07* | DESIGN_ACTIVITY _LOCATION Design activity city, state and zip code \é\(/)z(a)gen, MI 48397- REQ*
08 | DESIGN_APPROVAL_NAME Person who approved design A.TAYLOR REQ

STEWART &
- . STEVENSON
09 | DESIGN_CONTRACTOR Original design contractor SERVICES, SEALY -
TEXAS U.S.A.
10 | DISTRIBUTION_CODE Distribution Statement (A, B, C, D, E, X) A REQ
11 | DRAWING_APPROVAL_NAME Person who approved drawing A TAYLOR REQ
12 | DRAWING_DATE Date original drawing created YY-MM-DD REQ
13 | DRAWING_NUMBER Dra}wmg number the part/assembly is 12414568 REQ
defined on
14 | DRAWING_REV Revision of current drawing B Legacy
15 | DRAWN_BY Person who created original drawing JWENNER REQ
16 | ENGINEER_NAME_1 Primary design engineer A.WURFEL REQ
17 | ENGINEER_NAME 2 Secondary design engineer J.ZEBROWSKI -
18 | ERR_ECP_APPROVAL Approving official of latest ECP N.TAUBE -
19 | ERR_ECP_DATE Date current revision was released YY-MM-DD REQ
20 | ERR_ECP_NUMBER ECP that caused current revision TACV1234 REQ
21 | ITAR Controll_ed by International Traffic in Arms YES REQ
Regulation
22 | JEWEL_BEARING YES_-NO PARAMETER, contains jewel NO )
bearing
23 | MATERIAL_ENGINEER Person who approved material for design M.CHURCH REQ
24 | MATL_CLASS Automatically filled out -
25 | MATL_GRADE Automatically filled out -
26 | MATL_HEAT TREAT Automatically filled out -
27 | MATL_NAME Automatically filled out -
28 | MATL_SHAPE Automatically filled out -
29 | MATL_SPECNO Automatically filled out -
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30 | MATL_TYPE Automatically filled out -

31 | MATL_UNS_NO Automatically filled out -

32 | MODEL_REV Revision of current model B Legacy
33 | MODELER_NAME_1 Primary Pro/E modeler J.WENNER REQ
34 | NEXT_ASSY_1 E'gségi)g,{l‘f’lhﬁgfj\fvg partno. (shall match | 15419847 001 REQ
35 | NEXT_ASSY_2 Second next higher assy part no. -

36 | NEXT_ASSY_3 Third next higher assy part no. -

37 | NEXT_ASSY 4 Fourth next higher assy part no. -

38 | NEXT_ASSY 5 Fifth next higher assy part no. -

39 | NEXT_ASSY_6 Sixth next higher assy part no. -

40 | NEXT_ASSY 7 Seventh next higher assy part no. -

41 | NEXT_ASSY_8 Eighth next higher assy part no. -

42* | NOMENCLATURE Drawing name. (See paragraph 3.12.3) ggggé SGE{\/A E\va\; REQ*
43 | NOMENCLATURE_1 First line of drawing nomenclature BODY ASSEMBLY, | -

44 | NOMENCLATURE 2 Second line of drawing nomenclature CARGO, MTV LWB | -

45 | NOMENCLATURE_3 Third line of drawing nomenclature -

46 | OZONE_DEPLETING_CHEMICAL ;Ef'n :::lg PARAMETER, ozone depleting | -

47 | PART_NUMBER Item part number 12423205 REQ
48 | PMIC Precious Metal Indicator Code A -

49 | QA_ENGINEER_NAME Quality assurance engineer P.FIESTER REQ
50 REMARKS See paragraph 3.12.2 PRELIMINARY Legacy
51 | SOURCE_CONTROL YES-NO PARAMETER, source control NO -

52 | SPEC_CONTROL YES-NO parameter, spec control NO -

53 | SPEC_NUMBER ggfgigﬁfgio” Number, Used on SPEC ASME B18.2.1 -

54 | SPECIALTY_METAL YES-NO PARAMETER, specialty metal NO -
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55 | TOLERANCE_1 PLACE Default tolerance if indicated on drawing Nl -

56 | TOLERANCE 2 PLACE Default tolerance if indicated on drawing .03 -

57 | TOLERANCE_3 PLACE Default tolerance if indicated on drawing .020 -

58 | TOLERANCE_ANG g)rzl:zLijrl];angular tolerance if indicated on 5 )
59* | UNIT_WEIGHT Mass value. (See paragraph 3.12.4) 1.25 REQ*
60 | USED _ON_1 First used on item FMTV A1P2 REQ
61 | USED_ON_2 Second used on item -

62 | USED_ON_3 Third used on item -

63 | USED_ON_4 Fourth used on item -

64 | USED_ON_ 5 Fifth used on item -

65 | USED_ON_6 Sixth used on item -

66 | USED ON_7 Seventh used on item -

67 | USED_ON_8 Eighth used on item -

68 | WEIGHT UNIT Automatically filled out - toolkit kg )

application

TABLE 3: PART PARAMETERS

* These parameter values are required and are automatically generated from the FMTV start part and
assembly relations.

FMTV-MODELING-STD-100T Rev.L

3.12.1 The parameter CAGE_CODE refers to the original design activity.

If the current

design activity is different than the original design activity then the current one is entered into
the CURRENT_CAGE_CODE field. A table must also be placed on the drawing showing the

current design activity cage code (see sample below).

ARMAMENT RESEARCH,
PICATINNY ARSENAL,

CURRENT DESIGN ACTIVITY CAGE CODE

Us ARMY

DEVELOFMENT AND ENGINEERING CENTER
NEW JERSEY 07806-3000

19200
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3.12.2 The parameter REMARKS should initially default to PRELIMINARY. This will

automatically appear on the drawing until the value is removed during the final stage of the

release process.

3.12.3 The parameter NOMENCLATURE will automatically be assigned a value based upon

FMTYV start part relations. The value is equal to the sum of the individual parameters
NOMENCLATURE_1, NOMENCLATURE_2, and NOMENCLATURE_3, which shall be

entered appropriately by the modeler.

3.12.4 The part or assembly parameter UNIT_WEIGHT is automatically filled out by Creo

Parametric (PRO_MP_MASS calculated parameter) when the part or assembly is regenerated.
This is accomplished using relations found in the FMTV start parts. The parameter value for

unit weight shall be representative of the weight of its true physical counterpart.

3.13 Part Units

Creo Parametric system units shall match the following:

Unittype | METRIC | ENGLISH
Length mm in
Mass kg Ibm
Time sec sec
Temp °C °F

TABLE 4: UNIT SYSTEMS

Note: English and metric unit systems exist in the FMTV start parts
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4 Assembly Modeling Standards

4.1 Assembly Modeling Practice
4.1.1 Assemblies shall have all components and features of the assemblies defined, including
pins, screws, nuts, washers, the part number etc. This includes items such as decals, warning
labels, bulk items, etc., which are required to be attached to the assembly.

4.1.2 Assembly of models shall follow a logical sequence.

4.1.3 Assembly features shall only be used for features manufactured at the assembly level and
not for features created on individual parts.

4.1.4 All assembly models shall regenerate successfully with all features and components in
the unsuppressed status. When assemblies are modified, the next higher assembly shall also be
capable of being successfully regenerated.

4.1.5 All assembly components shall be fully constrained unless the function of the assembly

benefits from adding certain degrees of freedom through connections. The FIX constraint
should avoid being used. The use of Creo Mechanism joints, for example, is acceptable in this

case.

4.1.6 The latest FMTV_START_ASSY shall be used for assembly creation.

4.2 Tolerances

Refer to Section 3.2 Tolerances.

4.3 Model Notes
Refer to Section 3.5 Model Notes.

4.4 Assembly Default Datums

All assemblies will start with default datum planes and a default coordinate system identical to those
found in the FMTV start parts. The default datum planes shall be named FRONT_ASSY,
TOP_ASSY, and SIDE_ASSY. The coordinate system shall be named ACSO with its orientation as

follows; Z axis is elevation, X axis is along the length of the vehicle, Y axis across the vehicle width.
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45 Assembly File Names

Assemblies shall be named using the following convention:
CAGE_PartNumber.asm i.e. 19207 _12432300.asm

For additional guidelines for assembly naming refer to Section 3.8 Part File Names.

4.6 Model Views

All models shall have separately named views defining the TOP_VIEW, BOTTOM_VIEW,
LEFT_VIEW, RIGHT_VIEW, BACK_VIEW, FRONT_VIEW, and DEFAULT views. These views
exist in the FMTYV start part. The FRONT view is oriented facing the yellow (or primary) side of the
FRONT datum plane, with the yellow side of the TOP datum plane facing up. The remaining
orthogonal views follow standard third angle projection practice. Current drawing models should be
created such that the named views correspond to the existing drawing views. When applicable, the
addition of ROADSIDE and CURBSIDE views is recommended.

4.7 Assembly Layers

The following layers shall be used in assembly mode (these exist in the FMTYV start assembly).

Layer name Layer Assignments Default State
a. Only the cosmetic/curve feature describing the part identification Hide
ITEM_ID
- number
b. DTM_AXES All datum axes Hide
c. DTM_CSYS All datum coordinate systems Hide
d. DTM_CURVES All curve features Hide
e. DTM_PLANES All datum plane features Hide
f. DTM_POINTS All datum point features Hide
9. G_DTM_PLANES | Aj| geometric tolerancing datum planes Hide
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h. NOTES All assembly notes Hide
i SURFACES All surface features and quilts Hide
J. THREADS All cosmetic and actual threads Hide
k. XSEC_DATUMS All cross-section datums Hide

TABLE 5: ASSEMBLY LAYERS

48 Bulk Items

Bulk items are classified into two different categories. These items will be referred to as TYPE 1 and
TYPE 2 categories. TYPE 1 bulk items are commodities that are used in a volume, such as adhesives,
fluids, lubricants, etc. TYPE 2 bulk items are cut to length or stock parts, such as seals, gaskets,
convoluted tubing, tape, etc.

TYPE 1bulk items are non-solid representations of objects within an assembly. They shall be used for
all objects that must appear in the Bill of Material or PARTS LIST but do not require solid models.
Bulk items shall be used to represent adhesives, lubricants, sealants, paint, etc. Bulk items are a unique
subset of the .prt model type and are represented by a unique icon (paint can) in the Creo Parametric
Model Tree. New bulk items can be created by using the start_bulk.prt template in the Commonspace
Templates folder.

It is not acceptable to create a -500 suffix component of the base object in the assembly and add Table
relations to overwrite the parameters reported in the columns. The bulk item shall be created with the
proper cage code, name, and description to automatically populate the table repeat region. The typical
table relation for bulk items relates the reporting the quantity which is typically set to "AR".

TYPE 2 bulk items shall have a Creo Parametric 3D solid model to represent the item. The models

will either fall into the deformed/installed state or flexible component category.

4.9 Assembly Parameters

Follow the same guidelines as Section 3.12 Part Parameters.
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4.10 Relations
Relations shall have no errors upon regeneration. Relations found in feature ACSO of the FMTYV start

assembly are required.

4.11 Surface Finishes

Surface finishes shall be created on the assembly as required.

4.12 Reference Objects

Reference components displayed in phantom on installation or similar drawings should not be fully
associated 3D models. These should be developed using 2D curve data or 3D model data as required
(refer to Appendix D.3 for 2D and Appendix D.4 for 3D Lightweight Backdrop Creation. Any
components specifically defined on the drawing must have a valid associative 3D model as per

Paragraph 4.1.1.

4.13 Assembly Units

Follow the same guidelines as Section 3.13 Part Units.
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5 Drawing Creation Standard

5.1 Dimensions
Drawings shall display dimensions that are directly parametric to the model upon which they are

based. Specifically, these values shall be either driving or driven dimensions.

5.2 Geometric tolerances
Geometric tolerances shall be attached to the base dimensions when applicable and not added as

unattached notes.

5.3 Formats
Standard FMTYV 3D/TDP drawing formats located in the Standard CAD Template Library / Start Parts
and Formats in Windchill PDML.ink shall be used.

5.4 Drawing Setup Files
Standard FMTYV 3D/TDP drawing setup files (.dtl) located in the Standard CAD Template Library /
Configs in Windchill PDMLink shall be used.

5.5 Drawing Standards
The drawing standard used shall be ASME Y14.100-2013 and ASME Y14.5-2009. These standards

shall be called out in Notel of the drawing model.

5.6 Notes
All notes on drawings shall originate as model notes in .prt and .asm files, except when deemed
necessary.
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5.7 Drawing Views
2D draft entities shall be related to the drawing view to which it belongs. Views shall be capable of
being moved with no entities of the view being left behind.

5.8 Drawing Line-Weights

The following line weights and colors shall be used:

COLOR STYLE ITEMS
WHITE Normal Weight object lines, view arrows, format borders
YELLOW Thin Weight leader lines, dimensions, notes, symbols, tables
GRAY Phantom hidden object lines,
RED Bold special lines needing extra emphasis
WHITE Phantom Tangent Lines

TABLE 6: DRAWING LINE WEIGHTS

5.9 Quality Assurance Information
The preferred method for identifying Quality Assurance Information is on the product drawing instead

of having a separate QAP sheet.

5.10 Distribution Statement
The drawing distribution statement shall appear on each sheet of a drawing. (This is automatically

accomplished when the model note Distribution_Note is filled out in the drawing model.)

5.11 Revision Block
Revision blocks shall conform to ASME Y14.35M

5.11.1 For legacy conversion ECP’s, include only the latest revision, redrawn with

change/redrawn without change and ECP number in lieu of full delineation of the changes on
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the drawing for Administrative changes. For individual Major or Minor changes, those
changes shall be listed in the revision block.

5.11.2 For design effort ECPs that make drawing changes the revision block shallincluding the
latest revision, redrawn with change, ECP number and full delineation of the changes on the

drawing.

5.11.3 For design effort ECPs that release a new drawing the revision block shall include

Initial Release, Product Baseline, and the ECP number.

5.12 Associated Models

All parts that are defined by a drawing shall be related to the drawing even if they are not used in a

view on the drawing.

5.13 Parameters
The following parameters shall be filled out for the drawing model:
e Part Number
e Drawing_Date
e Drawn_By
e Modeler_Name_1
e Checker_Name
e Engineer_Name_1
e Material_Engineer
e Design_Approval_Name
e Nomenclature
e QA_Engineer_Name
e Drawing_Number
e Revision
e Distribution_Code
o ltar

e Err_Ecp_Number
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e Ermr_Ecp_Date*
e Err_Ecp_Approval*

*These parameters are not required to be filled out at the In Work state. Their values shall be
determined later in the release process.

514 Layers

Drawing layers may be created as required to properly display information on the drawing. Layer
status may be set (this works independent of the part/assembly) as required to properly display

information on the drawing.

5.15 File Names

Drawings shall be named using the following convention:

CAGE_DrawingNumber.drw i.e. 19207 12428511.drw

5.16 Drawing BOM Balloons
BOM balloons will use a standard diameter of 0.375 inches (9.525 mm). If the numbers within the
balloon extend beyond the balloon then the size of the text will be decreased to best fit within the

standard balloon. Refer to Appendix C.13 for additional information.
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Creo Parametric object templates are used to customize the default content of newly created

objects. Object templates belong to one of two categories: model templates (also known as start parts)

and drawing templates. Model templates are standard Creo Parametric models that contain predefined

features, layers, parameters, named views, and other attributes. Drawing templates are special drawing

files that contain instructions to create drawing items, including views, tables, formats, symbols, snap

lines, notes, parametric notes, and dimensions. Drawing templates are not currently used in the FMTV

environment. The basis for a drawing is the Creo Parametric format.

6.1 Start Parts

The start parts already contain a default coordinate system, default datum planes, views, layers,

notes, relations, and parameters. There are start parts developed for solid models, sheetmetal models,

and assembly models as named be

e fmtv_start part.prt

low.

e fmtv_start _shtml_part.prt

e fmtv_start_assy.asm

e fmtv_start diagram.dgm

The parameters that are part of the start models are listed below in Table 7, most of which are
required by the PAM-MTYV 3D/TDP standards.

Parameter Name Parameter Description Format Example Source
AGENCY Agency or service US ARMY Relation
AUTO_PART_NUMBER* Yes-No, Used in relation YES User
CABLING_ASSY* Yes-No, Set to YES for Cabling assembly | NO User
CAGE_CODE Original Design Activity CAGE Code 19207 Relation
CATALOG_NOMENCLATURE Nomenclature assigned by supply User
CHECKER_NAME Person that checked original K.BALL User
CIRCUIT_NUMBER* Circuit Number used for Electrical J159 User
CONTRACT_NUMBER Contract # - original design contract DAAEQ7-03-C-S023 User
DESIGN ACTIVITY Design Activity (from relations) TANK AUTOMOTIVE & Relation
ARMAMENTS COMMAND
DESIGN_ACTIVITY _LOCATION | Design Activity City, State and Zip Code | \wARREN, MI 48397-5000 Relation
(from Relations)
DESIGN_APPROVAL_NAME Person who approved design A TAYLOR User

FMTV-MODELING-STD-100T Rev.L
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chemical

DESIGN_CONTRACTOR Original design contractor STEWART & STEVENSON User
SERVICES, SEALY TEXAS U.S.A.
DISTRIBUTION_CODE Distribution Statement (A,B,C,D,E,X) A User
DRAWING_APPROVAL_NAME Person who approved drawing A.TAYLOR User
DRAWING_DATE Date original drawing created YY-MM-DD User
DRAWING_NUMBER Drawing Number 12423205 User
DRAWN_BY Person who created original drawing J.WENNER User
ENGINEER_NAME_1 Primary design engineer AWURFEL User
ENGINEER_NAME_2 Secondary design engineer J.ZEBROWSKI User
ERR_ECP_APPROVAL Approving official of latest ECP N.TAUBE User
ERR_ECP_DATE Date current revision released YY-MM-DD User
ERR_ECP_NUMBER ECP that caused current revision TACV1234 User
ITAR Controlled by International Traffic in YES User
Arms Regulation
JEWEL_BEARING Yes-No Parameter, contains jewel bear NO User
MATERIAL_ENGINEER Person who OK’d material for design M.CHURCH User
MATL_CLASS Automatically filled out (from relations) User
MATL_GRADE Automatically filled out (from relations) User
MATL_HEAT_TREAT User
MATL_NAME User
MATL_SHAPE User
MATL_SPECNO User
MATL_TYPE User
MATL_UNS_NO User
MC_ERRORS Model CHECK number of errors 0 User
MODELER_NAME_1 Primary Pro/E modeler J.WENNER User
MODEL_CHECK ModelCHECK last run on object YY-MM-DD User
NEXT_ASSY_1 First next higher assy part no. (must match | 12419847-001 User
Used_On_1 above)
NEXT_ASSY_2 Second next higher assy part no. User
NEXT_ASSY_3 Third next higher assy part no. User
NEXT_ASSY_4 Fourth next higher assy part no. User
NEXT_ASSY_5 Fifth next higher assy part no. User
NEXT_ASSY_6 Sixth next higher assy part no. User
NEXT_ASSY_7 Seventh next higher assy part no. User
NEXT_ASSY_8 Eighth next higher assy part no. User
NOMENCLATURE Part Name DODY ASSEMBLY, CARGO, MTV | Refation
NOMENCLATURE_1 (Ffiéjt d’:'at\’/;iln;;‘a(‘][fg;‘:rfe%f Nomenclature BODY ASSEMBLY, User
NOMENCLATURE 2 Second N_b_2 characters of Nomenclature CARGO, MTV LWB User
(for drawing)(from rel)
NOMENCLATURE 3 Remaining characters of Nomenclature User
- (for drawing)(from rel)
OZONE_DEPLETING_CHEMICAL | Yes-No Parameter, Ozone depleting NO User
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PART_NUMBER Item part number 12423205 Relation
PIPING_ASSY* Yes-No Parameter, set to YES for NO User
PMIC Precious Metal Indicator Code A User
PTC_COMMON_NAME* PTC Common Name User
QA_ENGINEER_NAME Quality Assurance engineer P.FIESTER User
REMARKS General Remarks PRELIMINARY User
SOURCE_CONTROL Yes-No Parameter, Source Control NO User
SPEC_CONTROL Yes-No Parameter, Spec Control NO User
SPEC_NUMBER Specification Number (SPEC Parts Only) | ASME B18.2.1 User
SPECIALTY_METAL Yes-No Parameter, Specialty Metal NO User
TOLERANCE_1_PLACE Default tolerance if indicated on drw 1 User
TOLERANCE_2_PLACE Default tolerance if indicated on drw .05 User
TOLERANCE_3 PLACE Default tolerance if indicated on drw .030 User
TOLERANCE_ANG Default tolerance if indicated on drw User
UNIT_WEIGHT Mass computed in Creo Parametric 1.25 User
USED ON_1 First used on item FMTV A1R User
USED_ON_2 Second used on item User
USED_ON_3 Third used on item User
USED_ON_4 Fourth used on item User
USED_ON_5 Fifth used on item User
USED_ON_6 Sixth used on item User
USED_ON_7 Seventh used on item User
USED_ON_8 Eighth used on item User
WEIGHT_UNIT Unit - Weight kg Relation

* Non-Designated Parameters

6.2 Formats

TABLE 7: OBJECT PARAMETERS

PdM-MTYV standard formats have been created to work with the PAM-MTYV start parts. These
formats are available in the Windchill PDMLink / STANDARD CAD TEMPLATE LIBRARY / Start

Parts and Formats. These are the only formats that shall be used when creating new or updating old

drawings for the FMTYV database. These formats are named using the following convention:

(Drawing Size)_(Vehicle Family)_(Unit System) (1)_(\Version)

FMTV-MODELING-STD-100T Rev.L

b fmtv_met 1 5.frm
c_fmtv_eng 1 5.frm
c_fmtv_met_1 5.frm
d_fmtv_eng_1 5.frm
d_fmtv_met_1 5.frm

e_fmtv_eng_1 5.frm
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7 Electrical

7.1 Schematics
7.1.1 Schematic File Names

Schematic naming convention shall follow the format below: (Note: Schematics are used for
reference to drive the overlay that is contained on the production drawing)
CageCode_PartNumber
Example:
19207_12506185.dgm
19207 _12506185-001.dgm (For tabulated harnesses.)

7.1.2 Schematic Overlay Process

Schematics shall be created using an overlay process. This procedure will insert an overlay of
the diagram into the drawing. When an overlay is used, anytime a diagram updates or changes,
it will change on all drawings where the overlay exists. Overlays will not create a snapshot in

time of the present state of a diagram, it will update with any changes parametrically.

Overlays will also require that the formatting be turned off in the diagram and the diagram saved
in that condition. If it is not turned off, there will be noticeable differences in the title blocks and

formatting. The formatting in a diagram is different from that of a drawing.

The overlay will need to be placed on a blank sheet in the drawing. This can be used to bring
diagram data into the drawing and relay the changes in the diagram to the drawing, but revisions
will not be possible from within the drawing. Use the rev block from the drawing to track the
changes for the diagram on the overlay sheet. Alternatively, the user can create a rev block in the
diagram to force the information to be updated in the diagram. It also keeps the diagram ready
to be printed independently. The rev block that would be on the blank sheet in the drawing gets

deleted to prevent a duplicate rev block from showing on the drawing.
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Diagram Setup:

e Turn off the page formatting on the sheet to be overlaid.
e Place a rev block on the diagram (This is only needed if the rev block from the drawing is not
utilized)
The diagram may need BLANK sheets added for the automatic tables to be populated with the

correct sheet number.

Drawing Setup:

Insert a blank sheet where the overlay should appear.
Delete the rev box from the new blank sheet; the diagram rev box will be used.

Insert the diagram overlay.

How to Insert an Overlay

Select Tools > Overlay

Select Add Overlay

Select Place Sheet

Select the diagram file to be inserted

Select Open

If the diagram is more than 1 sheet, it will ask which

sheet to insert.
Converting a Schematic that was previously Stand-Alone to Overlay
If a schematic already exists in the system as a standalone 19207 SC12345678.dgm file, the
following process should be used to incorporate the schematic into the drawing.

1. Rename the schematic from 19207 sc12345678.dgm to 19207_12345678.dgm

2. Create a DUPLICATE OBJECT of the existing schematic and name it
19207 _sc12345678.dgm (This is needed since the original, newly renamed, schematic will
still drive the drawing; however a schematic is needed to document the superseded schematic

from a CM perspecitve).
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3. Onthe DUPLICATE OBJECT schematic, add SUPERSEDED BY 12345678 above the title
block and update the rev block to state that the schematic was superseded and incorporated
into drawing 12345678.

4. Follow Creating a Diagram Overlay method.

7.1.3 Spool File Requirements
Spools should only be checked in by a Spool administrator. Only Spool administrators have the

rights to check items into the Spools folder and create or modify Spools within this folder. All
Spools should be checked in and stored in the Routed Systems/Spools LIBRARY in

Commonspace.

Spool naming convention shall follow the format below:

CageCode_PartNumber (Government Part Number or Spec Number)

Example:

19207_12423132-004.spl (Government Part Number)
81349 M16878/14BJE9.spl (Spec. Number)

Spool files shall include the following parameters:

Parameter Name Parameter Description Used On Example Value

Mil Spec Number of Governement Number of the 19207_12420924-
Name - 8 All Spools

wire, tubing, etc... 001
Cage_Code Cage Code used to fill BOM Table. All Spools 19207
Description Description used to fill BOM Table. All Spools \Ii}ﬁﬁtencal, 18 AWG,
Units Unit of Measurement All Spools mm/inch
Mass_Units Unit of Measurement All Spools kg
Density Density All Spools kg/mm~2

Color of the cable, wire insulation, or sheathing .
Color (See Table 20) All Spools White
Color_Code Code for the Color (See Table 20) All Spools WHT

. Wire/Cable
Insul_type Insulation Type Spools GXL
Wire_Gauge Wire gauge Wire/Cable 18 AWG
Spools
Min_Bend_Radius 'tl;gr?dmlnlmum radius a wire/cable/sheath can All Spools 8
Thickness The diameter of the wire/cable. \évlre/CabIe 2
pools
Number_of_Conductors The number of conductors in a cable. Cable Spools 5
Sheath_Type Specifies the type of sheathing for this spool. Sheath Spools | Tape, Tube, Shrink
Outer_Diameter Indicates the outer diameter of the tube sheathing. | Sheath Spools | 12
Preshrink_Inner_Diamete | Indicates the pre-shrunk diameter of SHRINK Sheath Spools | 10
r sheathing.
Wall_Thickness Indicates the thickness of the sheathing. Sheath Spools | 0.5
Width Specifies the tape width for tape sheathing. Sheath Spools | 20
TABLE 8: SPooL FILE PARAMETERS
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Not all parameters will be used depending on the type of spool used. Use all of the
parameters above when applicable.

Color Color Code
White WHT
Black BLK
Red RED
Blue BLU
Green GRN
Yellow YLW
Orange ORG
Gray GRY
Violet VLT
Brown BRN
Tan TAN
Pink PNK

Table 9: Color Code References

7.1.4 Schematic Spacing

Schematic shall use the minimum spacing required to prevent overlapping while being clearly
visible when printed on an A size sheet.

7.1.5 Schematic Tables

Schematic shall include a wire run table showing the following information:
Circuit, Wire, From, To, Color, Color Code, Gauge, Insulation, and Description.

Use table diagram_circuit_list.tbl located in Commonspace

FROM COLOR

CIRCUIT WIRE couponnt Temm comonmnr. ey | COLOR | CEOF | GAUGE | INSULATION |DESCR IPT 10K

21-489 12423132-004 [5555‘%“‘?"“5_; Eég?-sf'f'f";H WHITE | wAT 4 GXL  |RIGHT FRONT MARKER FEED
21-489-A 12473132004 [-BSE)L‘SHTE\‘J?M{& El TE;Mizlb—G WHITE | WHT 14 GXL  |MARKER FEED

21-489-B 12423132004 [55?“SHTE‘?"‘;§,é Jaa Sﬂ“f'j' U WHITE | WHT B GXL  |RIGHT CENTER MARKER FEED
21-489-C 12423132004 [5550%“‘?“‘6,(‘: LI(?)SSEE'I:”?'E WHITE | WHT ¥ GXL  |RIGHT REAR FEED
21-489-D 12423132-004 fégc’SLEﬁ""'3'_H E’Q‘SEETM)'J WHITE | whT 14 GXL  |LEFT FRONT MARKER FEED

FIGURE 3: DIAGRAM_CIRCUIT_LIST.TBLE EXAMPLE

7.1.6 Schematic Circuit Numbers

Schematic circuit numbers shall follow the numbers assigned in document 12506111. Circuit
numbers that are used multiple places require an alpha-extension. (Example: 90-A, 90-B...)

7.1.7 Circuit Description
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Circuits shall show the circuit number, gauge, and color code on each wire. Circuit description
shall come from document 12506111.

P1260

FIGURE 4: CIRCUIT DESCRIPTION EXAMPLE

7.1.8 Reference Designators

Schematic reference designators shall follow the numbers assigned in document 12506111.

Common Reference Designators
Designator Description Example
CBXX Circuit Breakers CB01
TLXX Terminal Lugs TLOL
EXX Splices EO1
PXXX Male Connector P101
JXXX Female Connector J101
TBXX Terminal Box TB01
KXX Relays K01
SXX Switch S01

Table 10: Common Reference Designators

7.1.9 Connector Description

Connectors shall show the reference designator, connector function, and pin-out orientation on
every connector. Refer to Figure 5

PI260

o
|
RIGHT MAIN WINCH
fe

FIGURE 5: CONNECTOR EXAMPLE
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7.1.10 Phantom Box Requirements

Phantom boxes shall be used when a system or sub-system is shown in a simplified form.
Phantom boxes require a label of 6.35 mm (.25 inch) height that describes the sub-system and
shall use the phantom line type. Refer to 6

e

£B5
[4:1}

i TL256

| " 1L258

90 02 BLKE_I PVC,&OU\‘ASS;'»

1204 02 BLE_IPNC _BOOV_ 25 ——————

1405 0F_BLE_1PYC_B0OV_456 4‘*

TL25T

12442791 CONVERTER BOX
FIGURE 6: PHANTOM BOX EXAMPLE

7.1.11Schematic Symbols

Schematic symbol text orientation shall be primarily left to right and secondary bottom to top.
The symbol should be descriptive and should show reference designators and pins. When printed
on an A size print, the symbol should be clearly visible.
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7.1.12Twisted Pairs/Shields

Twisted Pair wires shall be shown as needed per design intent, while shields should always be
shown. (Refer to Figure 7: Rigid or Smooth lines are acceptable)

N XX

FIGURE 7: TWISTED PAIR(S) EXAMPLE - RIGID VS. SMOOTH

7.1.13Splices

Butt splices, not through splices shall be used when splicing wires.
Note: Splices are a manufacturing process and not a part.

7.1.14Wire Breaks

Wire breaks shall be depicted as follows, with the text indicating (SH.#, REF_DES).
(Refer to Figure 8)

TL26D

| +——WIRE_NUMBER-14 AWG-WHT%@H #, REF_DES

FIGURE 8: WIRE BREAK EXAMPLE

7.1.15Schematic Layout

The schematic should flow from left to right.

7.1.16 Top-Level Schematics

Top-level schematics shall be organized by function; meaning one function per page. (Example:
ABS, CTIS). Phantom box section above applies to top-level schematics. A visual representation
of connector contact gender shall be shown.

7.1.17Start Part (Diagram)

Refer to Section 6.1 - Start Parts
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7.1.18Formats (Diagram)
Refer to Section 6.2 — Formats
7.1.19Schematic Diagram File

The schematic diagram file shall be promoted along with the drawing and models. The
parameters for the diagram file shall match those of the drawing and models. The schematic

revision shall also match the revision of the drawing where the overlay is located on.
7.1.20Source Control Drawing Schematics

At a minimum, an Interface Control Diagram shall be included on Source Control Drawings;

however, a schematic is preferred when sufficient data is available.
7.1.21Drawing Properties

Diagram files shall use fmtv_diagram_1_1.dtl to provide correct setup for diagram

7.2 2D Drawings

7.2.1 Tables

Two Dimensional drawings shall include a Bill of Material table listing all components used and
showing reference designators. Also, a harness variation table shall be shown listing all harness
variations. harness_bom.tbl (or harness_drawing_table.tbl) table (Figure 9) can be utilized
which is located in Commonspace.

Some relations may have to be written in order for the table to look correct. Two tables are
listed as either can be used based on preference.

12| 2000 mm  [RA55809-A5IC TAPE, INSULATED, ELECTRICAL 58536

I 150 nm_|12420956 TAPE, GLASS CLOTH 19207

19 300 wm_ [1242024-001 TUBING. CONVOLUTED 19207

g 150 mm_ [12420829-00] SLEEVING, INSULATION 19207

8 2743 nm | 12420924-002 TUBING, CONVOLUTED 19207

7 9145 om | 12423132-004 WIRE, ELECTRICAL. GAL 19207

§ 3 MS2T 144-2 CONN, PLUG, ELECT SOCRET 36906 |83, B2 A1

5 3 M320659-127 LUG, TERMINAL 96506 TL200, TL199, TLIAS

2 6 Ma3436/1- BAND MARKER 81349

3 \ ATC-30 FUSE. 30 AMP IE

2 \ 12424956 FUSE/CIRCUIT BREARER HOLDER, ATC 19207

| \ 12420925-007 MARKER, HEAT BONDABLE WIRE 19207

FAKNJDOW PART NUMBER DESCRIPTION CAGE CODE JEERLICE
PARTS LIST

FIGURE 9: HARNESS_ BOM.TBL SAMPLE

FMTV-MODELING-STD-100T Rev.L Page 35 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

7.2.2 Connector Pin Position

Connector pin position shall be shown from the front face and label as the front. Reference
designator and function shall be shown as required. Empty terminals will be plugged per
12420908.

7.2.3 Connector Description

Connector reference designators and function/description shall be shown. All connectors shall
show all components with pin outs.

7.2.4 Harness Dimensions

Harnesses shall be dimensioned from connector front face, centerline of bundle, or center of
eyelet. Dimension units are vendor specific.

7.2.5 Two Dimensional Drawing Notes
Two Dimensional Drawings shall include the following notes:

e SCOPE AND GENERAL REQUIREMENTS FOR
MANUFACTURING AND ACCEPTANCE OF ELECTRICAL
CABLE ASSEMBLIES SHALL BE IAW DRAWING
12420908.

e DIMENSIONS WITHOUT TOLERANCES SPECIFIED ARE
FOR REFERENCE ONLY AND SHALL NOT BE USED FOR
INSPECTION PURPOSES.

e ITEM IDENTIFICATION: APPLY THE FOLLOWING
MARKING IAW MIL-STD-130,
CAGECODE-PARTNUMBER-REV
MFR- MANUFACTURER'S CAGE CODE
DATE MFR YYYY/MM/DD
e ALL CIRCUIT NUMBERS AND REFERENCE
DESIGNATORS SHALL BE IAW 12506111.
(This note is used ONLY if the drawing has a schematic located on it)
e Any note required to show design intent or to clarify the manufacturing process.
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7.2.6 Splices

Splices locations shall be dimensioned and noted with the reference designator.
7.2.7 2D Harness Drawing Nomenclature

e Harness - A combination of wires, cables, connectors, and/or related components.

e Cable Assembly - Multiple conductors, single sheath between two connectors.

e Generic names are no longer acceptable (i.e. No drawing shall be titled CABLE
ASSY)

7.2.8 2D Harness Layout

When a harness has too much detail to show on a single page, detailed views shall be used on
additional pages.

7.3 3D Harness Modeling

7.3.1 Naming Convention

Refer to SECTION 3.8 - Part File Names as 3D harnesses follow the standard naming
convention
Sample Naming Convention:
The naming convention follows the following format for Routed Electrical Harnesses
(Note: do not use the same extension for an assembly and a part)
19207_12345678-600.asm (Routed Assembly)
19207_12345678-601.prt (Harness Part, within Routed Assembly)
19207 _12345678-650.mfg (Manufacture Part)
19207 _12345678-651.asm (Flat Harness Sub Assembly)
19207 _12345678-652.asm (sub-assembly in the manufacture part)

7.3.2 Connectors

Connector assemblies shall be used for connectors requiring other components (I.E. contacts,
plugs, TPA...) Connector assembly names shall follow the following convention:
CageCode_HarnessNumber-ReferenceDesignator.asm
(i.e. 19207_12345678-J01.asm)
Connector entry ports shall be named according to the pin name. For example if the pin is “1”;
the entry port shall be named “PORT_1” or if the pin is "A"; the entry port shall be named
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"PORT_A". ("ENTRY_PORT" is also acceptable for generic ports) Refer to Figure 10 for
example

[T 19207_12500000+/1 .45k 00a073s
----- 5 MoteO_DESIGN_INTENT

""" ’E;—'E Froprietany_Mote
----- £= Distribution_Mate
----- = DRW_NOTE

""" L7 SIDE_ASSY <
----- £7 TOP_ASSY f;
""" A7 FROMT_ASSY

2 ACS0 4
B 19207_12253040-3PRT | 9.21123%
[T 19207 _12258939-2-902, 45| 0.000573
£
[#

(] 19207_12258933-1-902.PF| 0.000E19
(7] 19207_12258933-1-902 PF|0.000619 |
A PORT_1 I
-2« PORT_2 '
-2« PORT_3

----- P Inzert Here <
FIGURE 10: CONNECTOR ASSEMBLY EXAMPLE

7.3.3 Interferences

Wiring interferences are only acceptable within its own harness part.

Enclosures: All wires should be contained within the box. Multiple harnesses are allowed to
intersect within the enclosure only if interference is unavoidable.

7.3.4 Logical Reference

3D harness models shall be “driven” by a schematic and not created without reference to a
schematic.

7.3.5 Splices

19207 _Splice.prt shall be utilized, the part is located in the / STANDARD CAD TEMPLATE
LIBRARY / Start Parts and Formats folder in Commonspace.
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7.4 Electrical Checklists

Harness Assembly Checklist

Harness Assembly

[l File Name: CageCode_HarnessPartNo-600.asm
Skeleton Name: CageCode_HarnessPartNo_skel.asm (Skeleton is NOT required, applies to all steps
U below)
[] All connector assemblies are assembled to a coordinate system in the harness skeleton part
[l The harness path coordinates, points, and axes are all in the skeleton part
[ ] All harness parts (i.e. band markers, ....) are assembled to a coordinate in the skeleton part
[l The correct layers have been created in the assembly following the modeling standards
[ ] All unnecessary layers are hidden in the skeleton and assembly
[ The assembly and skeleton were created using the correct start part
The skeleton features have names that represent each features purpose, i.e. a coordinate system for a
= connector is named using the reference designator of the connector.
[1 Band markers have been placed behind the connectors following the manufacturing standards
[ 1 The harness identification marker has been placed
[ ] Splices have been attached to a location point on the harness network
1 The correct splice part has been used, splice.prt
The harness assembly does not have any interference with objects along the routing path and does not
= interfere with other harnesses. Wiring interferences within the assembly are acceptable.
[l The correct assembly structure was used, following all the electrical modeling standards
[] Isthe unit weight accurate and reasonable for the harness
[l All parameters have been completed
[l Model check has been completed on this assembly
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Connector Assemblies

File Name: CageCode_HarnessPartNo-RefDes.prt

Skeleton Name: CageCode_ HarnessPartNo-RefDes_skel.prt (Skeleton is NOT required, applies to all
steps below)

All connector parts are assembled to a coordinate system in the skeleton part

Entry port coordinate systems are named Port_# and are located in the main assembly

Entry port coordinate systems have the positive z axis pointing out of the connector base

The correct layers have been created in the assembly following the modeling standards

All unnecessary layers are hidden in the connector skeleton and assembly

The assembly and skeleton were created using the correct start part

The skeleton features have names that represent each features purpose, i.e. a connector refdes
The connector assembly includes all parts that are needed for the connector assembly

Nomenclatures match the harness assembly with the refdes included for each connector assembly

Correct assembly structure was used following the electrical modeling standards

Correct cage code was used on any hew connector parts, i.e. manufacturer cage codes

Dooogooogogoood g o

Model check has been completed on each connector assembly
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Harness Part

File Name: CageCode_HarnessPartNo-600.prt

Logical reference has been established

All connectors and components have been designated as cabling components

All entry ports have been designated

All wiring features have been created from the logical reference

A network has been created for the harness part’s routing path (optional)

All wires and cables have been routed and marked complete

Bundles representing convoluted tubing and insulation sheathing have been created and routed
Bundles have been accurately created following manufacturing standards

All non cabling components have been attached to the harness part, i.e. band markers, ...

All Spools needed for the harness, i.e. wires, sheaths, and tapes, have been read into the harness
The harness part was created using the correct start part

No cosmetic cabling features have been created in the harness, i.e. tape or markers.

The correct layers have been created in the assembly following the modeling standards

Do ooodood

Model check has been completed for this part. (Part must be opened from Pro/INTRALINK)
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Detail Drawing Checklist

Drawing File Setup

Correct format has been used.

Title block information is correct without spelling errors

Verify correct distribution and proprietary notes are used from 782 form
Distribution and proprietary notes are place on all sheets in the correct locations
Drawing title accurately represents the harness, it is not a generic title

Default part is the lower level flattened harness assembly.

There are no drawing items interfering with the rev block or standard notes area

The correct layers are in the drawing and hidden

N I I O

Model check has been completed on the drawing

Harness Layout and Views

A full layout view has been placed with overall dimensions

Detailed views are used for branches with several connection points
Harness scale is large enough to recognize the connectors and components
View is oriented to show the flat harness correctly

Cable display is set to thick on each view of the harness

No hidden lines are displayed within a view

Ooooood

Connector pin out views have been placed next to each connector

Harness Dimensions

[l Dimensions along the main trunk are created from a single starting point on the main trunk

[l Branch Dimensions are created from a single starting point from the main trunk

[] Dimensions are from the face of the connector to the breakout starting location

[] Dimensions for ring terminals are from the center of the eyelet to the breakout starting location

[ ] There are no stacked dimensions along a branch or the main trunk

[] Dimensions match those specified by the engineer, may require overwritten dimensions

[] Splice locations are dimensioned. If several are in one area, a detailed view should be used

[] All components along a path have a dimension to reference their location
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BOM Table and Balloons

BOM balloons are auto generated for all non cabling parts in the harness

BOM balloons for cabling components have been manually created, i.e. wires, tapes...

BOM balloons are separated for all occurrences of a component

BOM balloons are merged to a single leader line if several are present for a single component

BOM balloons should clearly mark where different wire spools are used

Use 3-region BOM table: Bottom region is the flat assembly, middle region is harness part, and top region
is the 3D harness assembly.

Items not needed in the table are filtered out of the table

OO O OoOoggdao

BOM Table has been sorted by reference designators

Notes and Rev Block

Notes and Revision information should be generated in the lower level flat harness assembly.
Notes have been created from the standard notes library

All connectors will have a functional description

All connectors, components, and splices are labeled with their reference designator

The drawing contains the minimum required notes (See below)

OO0dood

Any special requirements for manufacturing or installation have been noted on the drawing

Minimum Required Notes:

APPLICABLE STANDARDS/SPECIFICATIONS:
A. ASME Y14.100-2013
B. ASME Y14.5-2009

IEEE/ASTM SI 10 SHALL BE USED
IN CONVERTING AND ROUNDING OFF.
1 INCH = 25.4 mm APPLIES.

SCOPE AND GENERAL REQUIREMENTS FOR
MANUFACTURING AND ACCEPTANCE OF ELECTRICAL
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CABLE ASSEMBLIES SHALL BE IAW DRAWING
12420908.

ITEM IDENTIFICATION: APPLY THE FOLLOW
MARKING IAW MIL-STD-130,
CAGECODE-PARTNUMBER-REV
MFR- MANUFACTURER'S CAGE CODE
DATE MFR YYYY/MM/DD

DIMENSIONS WITHOUT TOLERANCES SPECIFIED ARE
FOR REFERENCE ONLY AND SHALL NOT BE USED FOR
INSPECTION PURPOSES.

ALL CIRCUIT NUMBERS AND REFERENCE DESIGNATORS SHALL BE IAW 12506111.
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Diagram Checklist

Sheet Setup

Correct format (e_fmtv_diag_1 2.frm)

Electrical_Diagram DTL File has been loaded or Start Template is used
All parameters for the diagram are completed

Grid set to 6mm Spacing

Snap to Grid is on when placing wires and components

File Name is CageCode_PartNo.dgm

Nomenclature 3 is set to “SCHEMATIC”

Scale set to NONE

Weight set to -----

Diagram has been checked for spelling errors

Dodogooodogoodg

All Layers are hidden.

Connectors & Symbols

[l Connectors have a unique reference designator, verified with the standards...
[ Connectors have complete parameters, read in from a library file
[ ] Connector pin designations are centered and the Reference Designator is at the top or left
[ Connectors have 12mm pin spacing and/or single pin connectors are resized to 26mm
[l Connectors and symbols have a description/function note
[ ] All connection nodes are on the grid
[ 1 Symbols have a reference designator assigned and displayed
[ ] Symbols have complete parameter files, read in from a library file if available
[l Correct splice symbols are used
] All connectors and symbols have Entry Ports entered in the parameters
[] Connectors are aligned and organized on the sheet
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Wires & Cables

Wires and cables are using the correct spool file

Wires and cable conductors have a circuit number assigned, verified with the standards...
Wires have a functional description added in the DESC parameter

Wires have a parametric note for the description at the connector pin

Wires are organized neatly on the sheet with as few crossovers as possible

Wire labels and wire descriptions are spaced 1 grid away from the connector

Wire labels are aligned with one another at the connector

Wire label format: Circuit#-Gauge AWG -ColorCode

Wire break symbols are aligned

Wires are spaced evenly and aligned on the grid

Wire labels are readable and have no interferences

Twisted wires are shown using jogs and aligned with one another, along the same side of the sheet

Cable Symbols are used to indicate cable assemblies

I

Cable conductors are assigned correctly in the cable

Tables
[] Circuit run table has been placed (diagram_circuit_list.tbl in common space)
[] Textintable cells is visible, column with is adequate to display contents

[] Verify that no information is missing from table and all circuits have completed parameters
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Notes and Revision Block (No longer needed with OVERLAY format)

Required Diagram Notes have been placed (See Below)
Rev Block has been completed, correct format

Revision level matches the drawing and assembly
Distribution note has been placed

Proprietary note has been placed, if required

OoOodood

Distribution and Proprietary notes match the 782 form and the drawing
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Example of a Schematic Layout:
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8 Piping

8.1 General Overview

Piping assemblies shall be created in a way that maintains a Stand Alone status. The fittings
and/or components used to set the start and end points of a route shall be able to be deleted or changed
at any time without causing a problem / failure to the pipe. The pipes shall not be dependent on the
top-level assembly where they will be installed. If this is not done the pipe can collapse or change with
the slightest modification to a fitting or a coordinate system (CS0) at a later time.

Piping routes shall be created in their own separate Creo Parametric assembly file to break any
ties to the master assembly. Isolating the piping routes keeps the routes and all of its extensions
separate and contained. The new piping assembly is created using the FMTV_Start_Assembly file. A
part shall be fabricated later using the same base part number with "_p" and the extension of .prt. This

part file is a dependent of the assembly file and is created from the pipe route in the assembly file.

The piping assembly file shall be fully constrained in the upper level assembly. The actual
constraints are left to user discretion. Components and CSO0s shall be placed to set the start and end
points for the route. Components such as fittings may be constrained to vehicle geometry to set initial
locations, but require an edit definition to break the association to existing geometry in order to

establish a standalone model.

Note: All Piping Assemblies and Line Stocks shall be created in METRIC units only.
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8.2 Line Stock Overview

A Line Stock file contains the shape, size, and material needed to be projected along the piping
path in the fabrication process. The Line Stock file defines the physical attributes of the hose.
Material and mass properties are defined with the Line Stock file and shall not be duplicated by
entering material specification into the material file of the part. The minimum bend radius of the hose
shall also be defined in the Line Stock file.

Line stocks should be pulled from the / STANDARD CAD TEMPLATE LIBRARY / Routed_Systems /

Line Stock LIBRARY in Commonspace. The Line Stock folder is controlled by Line Stock
administrators. Only Line Stock administrators have the rights to check items into the Line Stock
folder and create or modify Line Stocks. All Line Stocks shall be checked in and stored in the Routed

Systems/Line Stock folder in Commonspace; see Figure 11.

=[] Routed_Systems

[ Cabling_Hardware

] Conmectar_Parstneters
el ine_Stocks
[T Misc_Hardvweare
[C Piping_Hardware
] RSD_catalog

1 Spools

FIGURE 11: COMMONSPACE FOLDER STRUCTURE

Naming Convention of Line Stocks:
e Each file is created in the master library and is named according to the MIL specification or

-SAE number in addition to the diameter size and type; see Figures 12 & 13.

‘[E;_J sae_jB44_625_od stk 2 rmil-chi-1 34 44g-250-id stk
Diameter Size SAE # or spec. Inner or Outer Diameter
FIGURE 12: SAE LINE STOCK EXAMPLE FIGURE 13: MIL SPEC LINE STOCK EXAMPLE
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e If no specification is available, the new line stock should be named after the part that is using
the pipe. This may be applicable to Source Control Drawings.

e |If the type and size of line-stock does not exist in Commonspace, send the line stock
specification to a line stock administrator so it can be created.

e The Line Stock is assigned first in the set-up process of creating a route; see Figure 14.

MenuManaser

Active Asm
Component
Pipeline
Foute
Fitting
Modify Pipe
Modify Dim
Fegenerate
Fabrication
Drawing

Info

Spec DB

Line Stock

Insulation
Bend Allow
Set Display

Done/Return Use Create to make a new line stock.

Use "Write" to write a Line
Stock into a local workspace.
Line Stock admin's are the
only people who can use this

function. Use read to load an existing line stock. Do a

search in common space first and checkout the
Line Stock that is required. Never change or
modify existing line stocks.

List ' Notify a member of the Line stock admin of
Rename =2l any errors in line stocks in Commonspace.
Done/Return

FIGURE 14:LINE STOCK CREATE / READ

NOTE: Line Stocks shall be done in METRIC units.
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e Line Stocks contain information that is directly related to the pipe part; see Figures 15, 16, and 17.

This is the weight per
length of the hose or tube.
This number is provided
from the manufacturer or
spec. callout in kg/mm.

Minimum Bend /

Radius in mm

(i nestosc

Line Stock - 0_25IN~5_4MM_OD_TUBE

LineStock | Designuls | Defined |
General Parameters

Stock Mo

Material

Grade
— X Section

" Rectangular
% Circular

X

(1242057204

T~

Line Stock Type

IN:.fIan&Hher

I'IM"O D_¥_.0d4"w
Section Type
" Hollow

* Solid \

— Section Parameters

PpeOD |64

Section Type can be set to Solid or Hollow
depending on user preference. This will not
affect the Weight/Length outcome.

Thickness
Shape Type Comer Type
v Straight i ¥ Bend 2
[ Fitting (i
A
Weight./Length {1.792-005
Bend Radius f25
Bend Angle |30 45 30 60
Miter Cut Length Jo.o50.105
Miter Cut Number J123
g» Enterthe bend radius values.
v x | o |

FMTV-MODELING-STD-100T Rev.L
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[ nestoac x

Line Stock : 0_25IN-6_4MM_OD_TUBE

LineStock  Designfule | Defined |

Design Rule Parameters

Max Overall Length | 10000
Min Segment Length [1

Max Segment Length |236.22
Max Bends Number {100
Min Bend Separation ID

Min Straight Length [10

Min Bend Radius |25
Max Bend Radius 1000
Min Bend Angle [15
Max Bend Angle [130
Bend Arc Threshold [165
Min Branch Separation |2

Min Branch Angle |30
Bend Table Name | NO_TABLE =l
g Maxmum pipe segment length.

v x | o |

FIGURE 16: LINE STOCK DESIGN RULE PARAMETERS
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fi= LineStock x|

Line Stock : 0_25IN-6_4MM_OD_TUBE

IJneStockI DesignFule Defined |

Uzer Defined Parameters

¥ |ineStock i~ Bend

Mame Yalue

N\ User Defined Parameters for
writing relations in special cases.

+| =|

v X = |

FIGURE 17: LINE STOCK DEFINED TAB
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A Line Stock can also be created with a .txt file in Notepad or similar program. The following

example shows all of the parameters needed to create a Line Stock; see Figure 18.

B mil-dtl-13444g-250-id.stk - Notepad
File Edit Format View Help

! Enter or modify parameters for the line stock.! You may use the help functionality of Pro/TABLE!
to enter pre-defined parameters.
STOCKNO TUBING

MATERIAL MIL-DTL-1344G
GRADE Al23

SECTION_TYPE HOLLOW

SHAPE STRAIGHT
CORMER_TYPES BEND

oD 12.7

WALL_THICKMNESS 3.17
BEND_RADIUS 1.5 2 3
BEND_ANGLE 90 45 &0
BEND_ARC_THRESHOLD 1a5
MAX_OVERALL_LENGTH 6.4516e+08
Max_MNUMBER_BENDS 5
MIN_BEND_SEPARATION 163871

MIN_STRAIGHT_LENGTH_END 163871
MIN_BEND_RADIUS 20483, 8
MAX_BEND_RADIUS 1.17987e+06
MIN_BEND_ANGLE 15
MAX_BEND_ANGLE 112.5

WT_LEN 5.69505e-05

MITER_CUT_LEN 819.353 1638.71 8193.53
MITER_CUT_MNUM 1 2 3

X_SECTION_TYPE CIRCULAR
RECTANGULAR_HEIGHT 32774.1
RECTANGULAR_WIDTH 32774.1
RECTANGULAR_ANGLE a0

BEND_TABELE_MAME NO_TAELE
MIN_BRANCH_SEPARATION 32774.1

MIN_BRANCH_ANGLE 30
MaX_SEGMENT_LENGTH 3.87096e+06
MIM_SEGMENT_LENGTH 16387.1
FIGURE 18: .TXT FILE OF A LINE STOCK
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8.3 Creating Routes / Pipelines

Pipe assemblies have a specific naming convention. A pipe assembly name is a combination of
the upper level assembly name and the pipe circuit number called out in the installation schematic.
The circuit number can be found in the schematic related to the installation. For example, for a pipe
assembly named 19207 12345678-6110.asm, the upper level assembly is 12345678 and the circuit
number is 110, and the hose size is .375". The pipe assembly is designated as a pipe by the "6" as the
first character in the dash number. Piping installations that are complex should have accompanying
schematic drawings. If a schematic is not provided, circuit numbers shall be defined within the
installation drawing.

If a circuit number is not provided, then one must be created. This is done by selecting the next
available number that has not already been used in the current piping installation. The circuit number
should be a three digit number. The three digits represent the hose type or size and should be
described in a table within the drawing. For example, the first number in pneumatic assembly circuit
numbers is used to designate either bulk tubing or crimped hose, and also to distinguish the bulk tubing

size. A sample pneumatic circuit number table is shown below; see Table 11.

Circuit Identification Hose/Tubing Type
0XX .25 Inch Bulk Tubing
1XX .375 Inch Bulk Tubing
2XX .50 Inch Bulk Tubing
3XX .625 Inch Bulk Tubing
5XX Hoses with Crimped Ends
8XX Hoses with Crimped Ends

TABLE 11: CIrcuIT ID TABLE

NOTE: All bulk tubing sizes are outer diameter and all rubber hose sizes are inner diameter.
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The fmtv_start_assy.asy has four parameters (see Table 12) that are dedicated to Pro/PIPING
that should be filled out in piping assemblies.  These parameters are PIPING_ASSY,
HOSE_LENGTH, WEIGHT_PER_LENGTH, and CIRCUIT_NUMBER. Piping assemblies should
have the PIPING_ASSY parameter set to YES. The default value is NO. The
WEIGHT_PER_LENGTH parameter should be filled in with the numeric value of the weight/length
given in the line stock file used in the piping assembly. When this is done, the HOSE_LENGTH
parameter will be filled in automatically. The CIRCUIT_NUMBER will also be automatically
generated as it takes the last 3 digits of the filename and fills in the parameter.

If the PIPING_ASSY parameter is set to YES, the PART_NUMBER parameter will need to be
filled out manually. The PART_NUMBER parameter in the piping assembly will be filled in with the
part number of the hose or tube it represents, i.e., the part number should be the number of the part that
would be purchased from a BOM. The piping assembly is just a 3-D representation of that part in its
routed state. The PART_NUMBER parameter is the number that will be listed on the assembly
drawing. For example, if a pneumatic piping assembly 12345678-6130 represents a piece of 3/8" bulk
tubing, with the part number 12420572-006, the FILE_NAME of the pipe assembly will be 12345678-
6130 and the PART_NUMBER will be 12420572-006. The CIRCUIT_NUMBER parameter would

automatically be filled in with 130 in this instance.

The following are four specific parameters in the fmtv_start_assy.asm that supports Pro/PIPING

Parameter Name Parameter Description Format Example | Input

YES/NO parameter. Defines if the

- . YES -
assembly is a piping assembly

01 | PIPING_ASSY

Automatically generated when

PIPING_ASSY is set to YES. 125 -

02 | HOSE_LENGTH

Numeric value of the weight/length given
03 | WEIGHT_PER_LENGTH in the line stock file (manually entered, ..00417
should be same as line stock file)

Automatically generated. Provides 3 digit

04 CIRCUIT_NUMBER S 110 -
- circuit number
TABLE 12: PIPING ASSEMBLY SPECIFIC PARAMETERS
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Port creation:

e Ports should always have the Z-axis orientated in the direction of pipe flow; see Figure 19.

FIGURE 19: SAMPLE HOSE FLOWING INTO PORT AND Z-AXIS DIRECTION

e The Z axis of the pipe port should be collinear to the Z axis of the fitting port.
o The centerline of the pipe needs to remain collinear to the Z axis of the fitting port beyond the

termination point of the fitting.
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o The user will determine the actual routing of the pipeline. There are many ways to route each

pipeline and each user will have a preferred method. Two methods are shown in Figure 20.

/7 SIDE_ASSY
£7 TOP_ASSY
£7 FRONT_ASSY
2¥x ACSO
HxACS1
xACS2
@-(1J 81343_SAEJ6-6_3001CA PRT
(7 81343_SAEJ6-6_1501C.PRT
ﬁx PORTO
w % APNTO
“¥x PORT1
w x APNT1
4 Line Stock id 130
o9 19207_12422476-001
& Pipe Set Start id 133
// Pipe To Point id 134
-4/ Pipe Extendid 136
/ Pipe To Point id 142
/ Pipe To Point id 148
&7 19207_12423246-6808_P PRT
& Insert Here

(T] 19207_125DUMMY-6115.ASM

£ Note0_DESIGN_INTENT
£ Note 1
£ Note2
£E Note3
£E Noted
£S5 Note5
£ Note6
£ Note7
£ Proprietary_Note

£ Distribution_Note

£= DRW_NOTE

& 15207_125DUMMY-800.PRT

£7 SIDE_ASSY

£7 TOP_ASSY

/7 FRONT_ASSY

2= ACSO

& Line Stock id 111

¥ 19207_125DUMMY-6115
¢/ Pipe Follow id 114

&7 19207_125DUMMY-6115_P.PRT

P Insert Here

FIGURE 20: EXAMPLE OF CREATING PIPE ROUTE IN SEGMENTS VS. FOLLOWING CURVE
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8.4  Fittings and Other Piping Parts

Fittings should be created / updated to include an entry port for each connection point; see Figure 21.

FIGURE 21: TWO EXAMPLES OF A SAMPLE TEE FITTING W/ ENTRY PORTS

e Entry ports shall follow the naming convention of PORT*, i.e., PORT1, PORT2, or PORTA,
PORTB, etc.

e The Z-axis of an entry port shall point out of the fitting; pipelines enter or exit the fitting
parallel to the Z-axis.

e The entry port should be where the pipe or hose terminates.

e Piping parts such as tie wraps, convoluted tubing, adhesive, etc. should be created and
assembled as bulk items.
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8.5 Fabricating / Creating Solid Pipes
Fabrication features create the actual part using the path and line stock as its guide. The
FMTV_Start_Part shall be used as a template.

Once a part is fabricated it creates a separate .PRT file. The fabricated pipe can be opened

individually when updating the layers.

Note: When fabricating a part, use the same -6xxx extension as the assembly with the addition of the
p". (e.g., 12345678-6123 p.prt)

1) Select Fabrication & Pipe Solid from the piping menu shown in Figure 22; a new window

will open.
: 2) Select the fmtv_start_part in the Copy From box at the bottom of the window;
Active Asm .
see Figure 105.
Component
Pipeline 3) Expand the pipe route in the left hand center section of the window; see Figure 23.
Foute
Fitting 4) Highlight the pipe segment under the pipe route; see Figure 23.
MModify Pipe
Modify D S . A .
odify Dirm 5) Add the new solid pipe name into the Solid Pipe parameter of the pipe segment;
s e see Figure 23.
Fabrication
Dirawing 6) (e.g. 19207_12345678-6123_p)
Setlp . .
Info 7) Select fmtv_start_part under the Start Part parameter of the pipe segment; see Figure 23.
¥ FaDRICA TION 8) Select Make, then OK; see Figure 24.
Cut Pipe
Delete Cut
Insulation
Delete Insul
Fipe Solid
Extract md|
Done/Return

FIGURE 22: CREATING PIPELINE
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5&6

[E Pipe Solid X
View |
Select Assembly {
’7 k| [19207_12423246-6208 /
SEGMENT SOLID NAME | |START PART |
[T 15207_12423246-6808

E}ﬂg 19207_12422476-001
- 19207_12422476-001

19207 124232466808 _F| ¥ |fmiv_start_pa

FIGURE 23: FABRICATING PIPELINE

The pipe solid is now created; see Figure 24 e

&

H¥

FIGURE 24: FABRICATED PIPELINE
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Figure 25 shows a standard pipe assembly with two fittings:
1. Create a pipe assembly with the correct naming convention

2. Assemble your fittings within the pipe assembly
a) Fittings should only be included in the piping assembly if they are permanently attached
to the hose, i.e., if the hose has crimped on hose ends.

3. Read the Line Stock into the assembly
4. Create a path for the individual pipe using a user's preferred method
5. Fabricate the pipe

(T] 15207_12423246-6808 ASM

----- £z NDtED_DESlGN_lNTENT\ 1
..... .f'_.E Moted
..... .{'_.E MNote?
..... .f'_.E Mote?
..... .f'_.E Moted
..... .f'_.E Mote5
..... .f'_.E Motek
..... .f'_.E Mote7
----- L= Proprictary_Mote
..... £ Distribution_Note

----- ES DRW_NOTE
----- F7F SIDE_ASSY
----- FF TOP_ASSY

""" £F FROMNT_ASSY
""" 2x ACSD Note: Straight Point is not a

2 R 5{, ACST .
\ _____ A ACS2 necessity as the modeler can
B[] 81343_SAEJG-6_3001CAFRT use Set Start at each port and

-] 81343_SAEJEE_1501C.PRT

extend from each to keep the

_____ X . STRAIGHT_POINTO pipe straight entering into the
W .

3l ;){u FORT1 fitting.
\ ..... « % STRAIGHT_POINT1

----- Line Stock id 130

..... 19207_12422476-001

R 5 Pipe Set Start id 133 / 4
..... < Pipe To Point id 134
..... <~ Pipe Bxtend id 136

..... < Pipe To Point id 142

..... 2/ Pipe To Point id 148

B¢~ 19207_12423246-6808_P PRT

‘. up Insert Here

FIGURE 25: SAMPLE PRO/PIPING DRAWING TREE
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8.6 Pipe Centerlines
The centerline for pipes shall be layered off in the drawing. This can be accomplished by
creating a new layer titled PIPING_BLANKED_LAYER or by placing them on the DTM_CURVES

layer.

8.7 Schematics

Schematics are required for any complex piping installation drawing and shall follow the
naming convention below;

CageCode_PartNumber
Example:

19207_12505846.dgm

19207_12505846.rsd

A complex piping installation drawing is defined as containing more than five piping
assemblies constrained within that corresponding installation. Those piping drawings of insufficient
complexity should have the piping routes and information defined in the installation drawing rather
than in a schematic. For those assemblies of sufficient complexity, a schematic should be referenced
in the notes on the installation drawing. Pro/DIAGRAM or Routed System Designer (RSD) may be
used to create the schematic. A schematic is not required to be parametrically linked to the piping
installation or drawing and should be used for reference purposes. If the schematic is part of the

drawing, the overlay process in section 7.1.2 can be used.

Schematics should consist of:

e Schematic Line Connection List; see Figure 26
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SCHEMATIC LINE COMWECTION LIST (COMPONENT REFERENCE DESIGNATORS, PORTS, CIRCUITS AND COLORSY - SORTED BY LINE NG
LINE INSTALLED | SCHEMATIC SIZE FRGM T2 CIRCULT LINE MATERIAL | FROM/TO LOCATION
NO LINE COLOR | LINE COLOR mm REF_DES PORT |REF_DES PORT PART NUMBER SH, VX

00| BLACK VIOLET 6.350 Dig 1.7 AT 1L AU TLTARY 12420572-004 SHE.F6  SH6.GB
ooz BLACK VIOLET 6.350 AL 2ACF oz 1.7 AURTLTARY 12420572-004 SHE,HE  SH6.F6
un4 BLACK BLACH £.330 C03 4.8 c02 4L CHARGING 124205072-004 SHo. A6 SHS,BY
uns BLACK VIOLET £.350 B0z 1.8 o4 1T AUKTLTARY 12420572-004 SHE F&  SHE,BS
00é BLACK BLACK 6. 350 C0¢ 4R Fo2 1R CHARGING 12420572-004 SHS, BT SHS. Ch
0o BLACK YIOLET &350 K2l 2R Al O1CR AUXTLTARY 12420572-004 SHE,G6  SH6, HE
Kl BLACK VIOLET §.350 <04 IB_R Al 1L AUXILTARY 12420572-004 SH5.05  SHE.CSH
nls BLACK GREEN §.350 ADI IB_R Cl3 IB_F REAR BRAKE 12420572-004 SH5.G8  SHS5 . HT
Ulg BLACK ORANGE 6350 ADI TACR Cl3 TAF FRONT BRAKE 12420572-004 SH5,H&  SH5 . HT
1z BLACK RED 9.525 ADZ Z2B.B o5 1.7 TRAILER SUPPLY 12420072-006 SHo. 67 SHS.HT
103 BLACK TELLOW 5.525 ADZ 24.B A2d 1R PARK BRAKE 124205672-006 SHa,G7 5HS,68

FIGURE 26: SAMPLE SCHEMATIC LINE CONNECTION LIST

e Symbol Legend; see Figure 27.

SYMBOL LEGEND, WITH PORT INDENTIFICATION NUMBERS

IR
7“[ e |_B
04
503
ey WITH YENTED DUMMY COUPLER I-B 2.8
L,{\/\/\/\/\/M r."/\l\vx" e I D N
48
- \\/ 04
WITH NON-VENTED DUMMY COUPLER
PHEUMATIC-HYDRAUL 1 CONVERTER AIR BRAKE COUPLERS AlR DRYER
REF_DES: BOI - BA2 REF_DES: Llo - €13 REF _DES: C03
FIGURE 27: SYMBOL LEGEND EXAMPLE
e A Color Legend for the diagram; see Figure 28.
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COLOR LEGEND
APPLICATON INSTALLED SCHEMATIC COLOR LINE
OR CIRCUIT COLOR COLOR APPEARANCE
CHARGING SYSTEM BLACK BLACK
REAR BRAKES BLACK GREEN
FRONT BRAKES BLACK ORANGE
PARKING BRAKES BLACK YELLOW
TRATLER SUPPLY/EMER. BLACK RED ——
TRATLER CONTROL/SERV. BLACK BLUE
AUXTLTARY AND CTI3S BLACK VIOLET ——
HEAT-SENSITTIVE STATHLESS GREY
YENT OR PILOT LINE BLACK BLACK-DASH - = = —
HYDRAULIC BRAKE LINE BLACK PINK

FIGURE 28: COLOR LEGEND EXAMPLE

e Piping diagram; see Figure 29.

27

)

DRAIN/FILL

22

FIGURE 29: SAMPLE PIPING DIAGRAM

FMTV-MODELING-STD-100T Rev.L Page 66 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

Installation drawings that do not have associated schematics should include a Line Connection

List in the installation drawing. This list defines the circuit ID for the routed pipes within the

installation.

Note: All circuits are labeled with proper identification numbers as described in section 8.3, table 11 and
components (symbols) are labeled with required reference designators that correspond with Figures 24

and 25.
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8.8 Piping Checklists
Pro Piping Checklist

Piping Assembly

File Name: CageCode_ PipeAssyNo-6XXX.asm

The circuit identification matches the specific type of hose or tubing designated on the required circuit
number table. Refer to section 14.3, table 22

The correct line stock has been used.

The correct layers have been created in the assembly following the modeling standards

All unnecessary layers are hidden in the assembly

The assembly was created using the correct start assembly.

There are no external references

Piping parameters (PIPING_ASSY, HOSE_LENGTH, WEIGHT_PER_LENGTH, PART_NUMBER) to be
filled out properly.

The correct assembly structure was used, following all the piping modeling standards

Is the unit weight accurate and reasonable for the pipe assembly

Appropriate parameters have been completed

Model check has been completed on this assembly

oDoogoono O gooogod g g

Centerline has been layered off

t

i)
D
)
Q
=

File Name: CageCode_PipeAssyNo-6 XXX p.prt

Logical reference has been established

Centerline has been layered off

The piping part circuit number matches the up assembly circuit number
All unnecessary layers are hidden in the part

Material file should not be called out

Is the unit weight accurate and reasonable for the pipe part
Appropriate parameters have been completed

The piping part was created using the correct start part

The correct layers have been created in the part following the modeling standards

Dodogooodogood

Model check has been completed for this part.
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Diagram Checklist

Sheet Setup

[l Correct format (e_fmtv_diag_1_2.frm)

] Appropriate parameters for the diagram are completed

[1 File Name is CageCode_PartNo.dgm or CageCode_PartNo.rsd
[] Nomenclature 3 is set to “SCHEMATIC”

[] Scale setto NONE

[l Weight set to -----

[] Diagram has been checked for spelling errors

] All Layers are hidden.

Tables

[] Schematic Line Connection List, Symbol and Color Legend have been placed

[] Textin table cells is visible, column with is adequate to display contents

Notes and Revision Block

Required Diagram Notes have been placed (See Below)
Rev Block has been completed, correct format

Revision level matches the drawing and assembly
Distribution note has been placed

Proprietary note has been placed, if required

OoO0dooaod

Distribution and Proprietary notes match the 782 form and the drawing

Required Diagram Notes

1. APPLICABLE STANDARDS/SPECIFICATIONS:
A. ASME Y14.100-2013
B. ASME Y14.5-2009

2. SCHEMATIC IS IAW DRAWING 19207_XXXXXXXX

FMTV-MODELING-STD-100T Rev.L Page 69 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

Appendices
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A Modeling Best Practices

A.1 Part Mode

e Name features appropriately.

e Patterns and pattern table use is recommended

e Sheetmetal parts shall always be created by starting with the standard fmtv_start_shtml_part.prt
start part.

e Save models early and often.

e Base features should be kept simple.

e Sketches should be kept simple.

e Incomplete features must be removed or completed.

e Relations should be clearly commented.

e Round/chamfer edges should generally not be used as references for other features.

e Rounds and chamfers should be created as late as possible in the modeling process. Draft
features should be created when most appropriate.

e Datum planes make the best sketch planes and references.

e Extruded feature depth definitions should reflect the design intent such that the depth remains
appropriate if the part is modified.

e When modeling from an existing drawing, try to create the models with features and
dimensions that limit the need for created dimensions on the drawing.

e Create new datum planes and axes for use as Geometric tolerance datums and axes. (Do not
rename the default datums found in the start part or use axes created by a feature.)

e Add geometric tolerance datums to the G_DTM_PLANES layer immediately after using the

“Set Datum” command in Creo Parametric.

A.2 Drawing Mode
e Standard FMTYV formats (in Standard CAD Template Library) must be used on drawings. The
correct standard format version depends on the work effort.
e Standard drawing setup files (.dtl) must be used. These are applied when the appropriate

Drawing Options are used.
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e Snapshots should not be used unless absolutely necessary.

o Drawings shall not contain overwritten dimensions unless required. For more information see
the Poor Modeling Practices in Appendix B.

e Views should be oriented using saved views or default datums, not model geometry.

« All notes symbols, and other 2D sketched entities should be related to the appropriate view or
object. (HINT: To check for this move the view(s) to see that no entities of the view are left
behind.)

A.3 Assembly Mode

e The first component or skeleton is the structural base for assembling all other components.

e Individual components or sub-assemblies should be colored differently for ease of viewing,
textures should avoid being used as they can slow down regeneration time.

e Components should be fully constrained with an appropriate combination of constraints (ex.
MATE, ALIGN, INSERT, COORDINATE SYSTEM, etc...). An exception to this rule is
components assembled using PTC Creo Mechanism. These components are allowed degrees of
freedom to simulate the movement of desired parts in an assembly. When PTC Creo
Mechanism is used a snapshot shall be stored in order to locate the “at rest” design position.
The FIX constraint should be avoided as a normal constraint as it was designed to finalize the
location of moved or packaged components where the final location is not yet known. The FIX

constraint will also hinder the use of Local Groups in Assembly.
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B Poor Modeling Practices

The following section explains how to avoid/work around several examples of poor modeling

practice.

B.1 Buried Features
Filling in holes/cuts with a protrusion is not acceptable. Occasionally ModelCHECK reports
cuts as buried features if the definition of the subtracted volume lies entirely within the existing solid.

This is an allowable buried feature.

B.2 Overwritten Dimensions

It is not acceptable to overwrite a dimension with @o in order to change the numeric value
from that which is defined in the model. Overwriting to show another character that may be found in a
table (i.e. A, B, C, etc.) is acceptable. The preferred method in this case would be to modify the

symbolic value of the dimension and show it using @s on the drawing.

B.3 Blind Feature Depth (= to material thickness)

When creating an extruded feature where the depth is intended to be through the part, the depth
shall not be entered as a numeric value equal to the material thickness of the part. The depth shall be
set using thru all, thru next, or up to surface as appropriate. Example: a cut is created through a part
but the depth is entered as a value equal to the material thickness of the part, the feature does not
update as desired if the material thickness is increased. If thru all were to be set as the defined feature

depth, the feature updates as expected when the part thickness is changed.

B.4 Excess Datums/Features

Extra, unused datums shall be cleaned up/removed from models. When modeling a part or
assembly, datums are created for construction of the part. Often some of these datums are not actually
required in the final iteration of the model. These datums shall be removed when possible. Remaining

features shall then be named as appropriate (i.e. naming a datum plane CL_PART if this is the intent).
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When a part datum is to be used for assembly purposes, be sure to name it so as to recognize its
purpose and to avoid accidental deletion. (i.e. ASSY_1)

B.5 View Name and Scale Not Parametric
The displayed view name and scale should be parametric to the model. If these are accidentally
removed at some point, attempt to “show” them in the drawing instead of keying in non-associative

text.

B.6 Bending Back Using the Wrong Sheetmetal Surface
Be sure after creating an unbend feature to use the correct surface when creating the bend back
feature. If the same surface is not selected, dimensions will not “show” properly on the drawing.

B.7 “0” Offset Assembly Mate

Unless an assembly constraint of Mate or Align requires the value of zero to make the design

flexible, it should be fixed as Coincident.

B.8 Congested Sketches

If a part has several dimensions defining its shape, these shall be broken up in to an appropriate
number of separate features. When roughly 10 or more dimensions are used to create a base feature
the sketch can become congested and difficult to work with. When roughly 20 or more dimensions are

found in a sketch, the computational time becomes cumbersome as well as the sketch being congested.

B.9 Flat pattern for Sheetmetal parts

Sheetmetal parts should not be created by starting with a flat pattern. Sheetmetal parts should
be modeled in an “as designed”, functional state. The flat pattern is created last (as necessary) for
manufacturing purposes, using Edit>Setup within the sheetmetal application. This creates a separate
flat instance which can be added to the drawing as a model independent from the generic fully formed

model used on all other views. The fully formed generic model may be changed and features added or
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deleted. As long as the family table is verified regularly, the flat patter will automatically update with
the changes done to the generic.
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C Miscellaneous Topics, Methods and Techniques

C.1 Model Relations

Each model has relations that can be found in part, feature, and sketch levels. Feature relations
take precedence over part relations as they occur later in the regeneration cycle. Relations found in
feature CSO/ACSO0 of the FMTYV start parts are required. These should not be changed from what is

contained in the start part.

C.2 Assembly Relations
(d#:# or d#:cid_#)

When part dimension symbols are shown in assembly mode, they contain two numbers (d#:#).
The first number is assigned from within the part and is the same number that will be seen if the
symbol was viewed from Part mode. The second number is assigned from within Assembly mode and
is the number that appears in the assembly coding table. This second number can also be found by
selecting Show > Session Id in the Relations dialog box. Creo Parametric will return, Component
<component_name> has Session ID #. Each part in the assembly is assigned a unique second number

but components with the same name will have the same Session ID.

Assembly relations that include family table components can also be written in the format
(d#:cid_#). The first number is still the same dimension number that was assigned at the part level but
"cid" is the Internal Component ID. The Internal Component ID is found by selecting Show > Info in
the Relations dialog box. The Internal Component ID is unique for every component even if the same
component is assembled twice in the same assembly. This method would be preferred if the same
component is assembled twice in the same assembly, a relation is written using the dimensions of the
component and then one of the components is replaced using Edit > Replace. Using the Internal

Component ID will ensure that the relation will update as intended.
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C.3 PROGRAM - From File vs From Model

The From File menu selection will be displayed only if the original PROGRAM has been
modified and there is text file of the program residing in the current working directory. If From File is
chosen, the editor will display the most recent listing of the program that resides on the local disk.

The From Model menu selection will extract the current listing associated with the object.
Upon initial creation of a PROGRAM, the user will not see these two choices, as Creo Parametric will
use the default listing associated with the model. After modifying the model file, then storing it to
disk, the user will be asked if he or she wishes to incorporate any changes. If the changes are
successfully incorporated, the model will be update accordingly and the design file will be deleted,

once again leaving only the default model listing.

C.4 Creo Parametric Layers

Layers are helpful in controlling the display of features, layers, and components in the Creo
Parametric environment. Entities are assigned to a layer and layer display status is set. Entities
created when using the FMTV start models are automatically set to the appropriate layer. The two
exceptions are cross section datum planes and GTOL datum planes. Additional layers may be created
as necessary to help organize things such as construction geometry, imported data, etc.

Display status may be set at different levels, for example: part, assembly, skeleton, and
drawing. Drawing display status acts independent of part, skeleton, and assembly layer settings. The
stored layer status will vary as appropriate for objects being worked on. When a part or assembly is
promoted into the release process its layer status must follow the modeling standard. The layer status
of a drawing should be set as required to show entities appropriately on the drawing. Isolate status is
often useful as explained in the datum target point example described in the following paragraph.

An entity may be set to more than one layer. This should be done as little as possible since the
only way to see the entity is to turn on all of the layers it resides on or to set one of them to isolate
status. For example, if an item is on two or more layers and any one of them has a hidden status, the
item will not be displayed. If a point feature is placed on three different layers (dtm_points,
inspection_points, and datum_target_points) the datum target points may be seen by settings the

datum_target_points layer status to isolate.
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NOTE: Setting the layer to isolate status displays entities on the layer regardless of the layer status of
other layers it resides in.

The following image shows the layers found in the FMTV start part. Note that the display

status is hidden for all layers. This is how archived objects are set so that the screen is not cluttered.

8o B 5| &F

[.Shng][ Lr:r'_.rerv][ Settings ™

= Layers
i-sm Hidden tems
B DTM_AXES
& DTM_CSYS
[ DTM_CURVES
B DTM_PLANES
.8 DTM_POINTS
.l G_DTM_PLANES
B ITEM_ID
& NOTES
- [B SURFACES
~[B THREADS
.l XSEC_DATUMS

FIGURE 30: LAYER TREE

B |8 |G | A

Show v | Layer ¥ | Settings ¥
15207 Hide
= Layers Unhide
EDTN Izolate
Activate
Deactivate

Save Status

Reset Status

Mew Layer...

Rename

Layer Properties...

FIGURE 31: SETTING VISIBILITY OF LAYERS
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It is acceptable to have layers unhidden as long as the config.pro and config.sup options listed
in FMTV Creo Configuration Settings prevent the screen from being cluttered upon initial retrieval of

a part, assembly, or drawing.

If a feature(s) on a layer(s), such as those generated by datum curves or a set datum operation,
displays despite these options being set then those layers must be hidden or the feature in question

must be moved to a layer that is controlled by the above config.pro options

C.5 Geometric Dimensioning and Tolerance (GD&T) used in Creo
Parametric

Per the TV modeling standards, geometric tolerance is required to be applied to three-
dimensional part and assembly models using Creo Parametric commands. The Insert > Annotations

> Geom Tol menu showing these commands is found below.

Menu Manager

............................... =

Geom Tol -
W GEOM TOL

Set Datum

Basic Dim

Inspect Dim

Specify Tol

Clear

Done/Return

FIGURE 32: INITIATEGTOL

Step 1 - Identify existing datums (or create new ones) to be used in constructing the datum
reference plane. Set the appropriate datums using the Set Datum command from the menu

above.
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Step 2 - Specify dimensions as basic as required. These dimensions made basic by using the
Basic Dim command from the menu above.
Step 3 - Specify dimensions as inspection as required. These dimensions made inspection by

using the Inspect Dim command from the menu above.

Step 4 - Describe features of size (such as holes and slots) with a feature control frame. The
feature control frame is created using the Specify Tol command from the menu above. The
geometric tolerance window appears as shown below. Select the button of the appropriate
geometric characteristic (i.e. position, concentricity, etc.) at the left hand side of the window.
Select the reference as required (ex: An edge for a straightness tolerance). Assign the new
tolerance if it is to appear in a dimension (ex: A hole diameter dimension for a position

tolerance.)

o .

1 Geometric Tolerance @

Model Refs | Datum Refs | Tol Value || Symbols

Model | FMTV_START_PART.PRT ]
Select Model...

Reference: To Be Selected Placement: To Be Placed

FDl0

Fa Y
w3

Type [ El:!ge v . Type

Select Entity. ..

REF STATUS: incomplete, please choose model and/or reference entity in "Model Refs”,

~jolsINDIo]]

S

FIGURE 33: GTOL MODEL REFERENCES TAB

Click the Datum Refs tab and then select appropriate primary, secondary, and tertiary datums

as references (if required). Make sure to set the proper material condition also.
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Model Refs | Datum Refs | Tol Value | Symbols |

| Datum References [ Unordersd |

[ ] Composite Tolerance

REF STATUS: incomplete, please choose model and//or reference entity in "Model Refs".

FIGURE 34: GTOL DATUM REFERENCES TAB

Click the Tol Value tab and enter the necessary tolerance value if required.

.
1 Geometric Tolerance

Model Refs | Datum Refs | Tol Value | Symbols |

Overall Tolerance | 0.001
MName gpl
[ ] Per Unit Tolerance

L7
/b/ Tolerance Value
[}

Material Condition | RFSino symbol)

%]

~olSINDlol
H

REF STATUS: incomplete, please choose model and/or reference entity in “Model Refs”.

FIGURE 35: GTOL TOLERANCE VALUE TAB

Finally, click the Symbols tab and select any required symbols, modifiers, additional text, or

projected tolerance descriptors.
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e
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| | Cancel

Model Refs | Datum Refs | Tol Value | Symbols

Symbols and Modifiers
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Projected Tolerance Zone
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REF STATUS: incomplete, please choose model and.for reference entity in "Model Refs".

FIGURE 36: GTOL SymBoLS TAB

C.6 Datum Planes and GTOL

Datum planes will not appear in the list of possible datums to reference in the Datum Refs
portion of the Geometric Tolerancing dialog box unless they have been set. To set a datum, select Set
Datum from the GEOM TOL menu, select the axis or plane to set, and then choose the placement
type for the datum from the Datum dialog box (Free or In Dim). Once the datum is set, it will be
available for referencing. The datum plane must also exist and be stored in the model showing the

Model field of the Models Refs portion of the Geometric Tolerance dialog box.

IMPORTANT: In order to delete a datum that has been set as a GTOL datum, it should first be cleared
using the Edit > Set Up > Geom Tol > Clear menu selection.

C.7 GTOL Datum Features Visibility

By default, all set datums will be displayed regardless of the existing display setting for datum
planes. This is true in parts, assemblies and drawings. For parts and assemblies, the only way to
remove the set datum is to place the datum on a layer and hide the layer. This is why it is required that

the modeler assigns set GTOL datums to the g_dtm_planes layer so that they may be turned off while
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modeling. In drawings, the set datums may either be turned off using the layer controls or erased using
the View > Show/Erase > Erase > Datum > Selected Item command.

C.8 ModelCHECK Process

ModelCHECK is used to compare the active part, assembly, or drawing to a set of required
configuration settings and report back items that are not set properly. It provides tools to help correct

the deficiencies.

C.8.1 ModelCHECK Procedures

ModelCHECK will be run interactively in a Creo Parametric session by each individual
designer. The designer will perform the task on each model/drawing he or she has worked on. Report
viewing will be accomplished using the built in Creo Parametric browser. Run ModelCHECK by
either clicking on the ModelCHECK Interactive Button from the Analysis pull down menu in the pull

down as shown below or using the MCK mapkey.

Insert Analysis Info Applications Tools Window FMTV -Mapkeys Help

EM&asure... 5 X }cl%ﬁ = L—LE
5 Oy % Model Analysis...
al okl Geometry 3

Mechanica Analysis. ..
Excel Analysis...

User-Defined Analysis. ..
Sensitivity Analysis...
Feasibility /Optimization...
Multi-Objective Design Study...

ModelCHECK »  ModelCHECK Interactive
Compare Part 3 ModelCHECK Regenerate
ModelCHECK Rule Check
Configure ModelCHECK
ModelCHECK Geometry Check

i Saved Analysis

g Hide All

Delete Al »

FIGURE 37: INITIATING MODELCHECK

A report summary will appear in the browser window that will look similar to Figure 38.
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(@ Browser

L < BERA RS = N =
Address |file:f':",-"'n"l.l':f'ModeICHECKfmc_reportsﬂﬂ?ﬂ?J2419131-4}02.p}'rtml M 6) Go
&)

PTC ModelCHECK
Al info | Param Layer Feat Relat Datum.

= Model: 19207_12419131-002.prt "% Status: ©

Date: Thu Feb 24 2005 13:56:33

Mode: Interactive

Config: check/fmtv.mch, start/fmtv_met.mcs, constant/mm.mcn

Checked by: DAMI BrnjacR

Last saved by: DAMI_BRNJACR - Pro/E v. 2500 b. 2004490
Creation date: Feb 10 2005

Qo W2 Tds T @23

Check ¥ Result |~
1|4 Early Rounds 2
2 | 0, Features with Edge References 3
(]
< | I | m

FIGURE 38: MODELCHECK SUMMARY

In order to view the detailed information, click on the tabs at the top of the browser (Info,
Param, Layer, Feat, Relat, Datum, and Misc). By default only errors and warnings are displayed.
In order to view general information and checks the check boxes next to the icons must be selected, as

shown in Figure 39 (numbers next to the icons show the number of related items).

Error Warning Info Pass

2 A
@0 VA2 i @23

FIGURE 39: MODELCHECK TYPES
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FIGURE 40: EXAMPLE OF MODELCHECK REPORT
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Clicking on any of the tabs makes that report page active. Clicking on the line number displays
a detailed description of the error or warning. Certain quick corrections, such as creating missing
layers and correcting layer status, can be made by ModelCHECK. It will take a few moments each
time a button is selected for the action to take place in the Creo Parametric session. After fixing all
errors run ModelCHECK again to make sure all items have been fixed. ModelCHECK will not save
the model or check it in to Commonspace; the user is required to complete those tasks when

appropriate.

C.8.2 FMTV ModelCHECK Error/Warning Summary

ModelCHECK is currently configured to operate in the interactive mode as described in the
ModelCHECK procedures. Any checks made resulting in errors must be fixed or the model may not
be promoted in Windchill PDMLink. When ModelCHECK is run the following checks will result in
an error:

1. Features 1-4 must match those found in the corresponding start part.

2. No suppressed or incomplete features may be found in models.

3. No frozen, suppressed, missing, and/or packaged components may be found in assemblies
(except when PTC Creo Mechanism is used).

Density must not be equal to “1” (ensures that a material file has been applied).

Features must be assigned to appropriate layers (by corresponding entity type).

All parameters found in the current start part/assembly must exist and be designated.

All layers found in the current start part/assembly must exist.

All views found in the current start part/assembly must exist.

© © N o g &

Insert mode may not be active.

10. Length and mass units must correspond with those in the start parts.

11. Unused drawing sheets are not allowed.

12. Any dimensions in drawings that may not be regenerated are not allowed.
13. Drawing format must be current.

14. The ModelCHECK ignore function may not be used.

15. Relation Check
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Any checks resulting in a warning shall be investigated, as they are case dependant occurrences.

When ModelCHECK is run the following checks will result in a warning:

1. Model name shall be equal to ##### *. (Checks that the file name begin with five numbers
and an underscore).

Relation errors shall not exist.

In general, erased drawing views shall not exist.

Round children (features that are children of rounds) are not advised as design best practice.

o M LN

Overwritten dimensions in drawings are not advised as a drawing best practice. In certain
instances they are required though, such as when showing dimensions for a family table part
where values A, B, C, etc. are required.

6. Draft feature children are not normally a design best practice.

7. DTL file settings shall match standard settings. If several items don’t match the standard

settings, this may indicate that the wrong .dtl file is applied to the drawing.

C.9 Geometry Checks

Creo Parametric issues a “geometry check” warning when a model is regenerated to indicate
that there may potentially be some risk with the model’s geometry. Geometry Check is a warning of
potential risk, but does not guarantee that there will be any problems with the model. Currently there

is no explicit indication of the severity of a geometry check.

Examples of a reported geometry check include:

A geometry check warning of a tiny edge detected. The geometry check probably doesn’t
affect the model accuracy or a drawing of said model. Some risk is present regarding the export of
“clean data” There is also a small amount of risk that further design changes may put the model at risk
of failure.

1. Assess Risk:
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Factors that may be used to determine the risk associated with a geometry check include:
e Location
e Anticipation of Design Modifications
e The Use of Downstream Applications: Including the use of shared data features and the
export of model data for simulation, analysis, and manufacturing.

e Quality of Design Techniques:

2. Investigate solutions:

Alternatives for resolving geometry issues include:

e Redefine the affected feature so the Geometry Check does not occur. This may be as
simple as creating a Sketcher constraint to align an edge to a vertex instead of having the
geometry driven by a dimension. In more complex cases, the elements of the feature may
need to be redefined (for example, by making a round using Surf-Surf instead of Edge
Chain.)

e Create the geometry with a different type of feature to allow more control over the explicit
referencing of existing geometry.

e Change the order of feature creation. For example, create a round feature earlier in the
feature list instead of near the end.

e Create the geometry with multiple features instead of one, or vice versa. This may allow
more explicit control over the references or shapes of the features involved.

e Finally, there may be the possibility that the geometry has been created according to the

design intent and there seems to be no way to avoid the Geometry Check.

3. Implement the best solution:

Choose the most efficient and appropriate solution from above.

C.10 Mapkeys
See FMTYV Creo Parametric Configuration Settings
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C.11 Symbols
Symbols are located in the Standard CAD Template Library / Symbols. They will also appear

in the default User Symbol directory in Creo Parametric. The list of available symbols in
Commonspace can grow as more are created. Separate sites can also create their own specific symbols

and stored outside of Commonspace if so desired.

C.12 Skeletons and Assemblies
C.12.1  Scope

Skeletons are models that are used for managing and building assemblies for installation and
configuration models and drawings. The skeleton is comprised of datum curves, points, surfaces, axes,
and coordinate systems but no solid features. The skeleton shall have a base coordinate system that
corresponds with the vehicle coordinate system (Refer to Appendix E) . The addition of multiple
skeletons to build complete vehicle configurations is allowed. Skeletons will generally look like a 2D
or 3D *“stick figure” sketch with many points, axes and coordinate systems. The skeleton needs to
have the necessary information to locate the components “in body” for a given installation. For several
Installation drawings, the components are spread out all over the vehicle, and constraining the

individual components by other means can be very time consuming and not robust.

C.122 Method

Each installation model shall contain a coordinate system corresponding with the vehicle three
dimensional reference system which is oriented with the ‘x” direction running along the centerline of
the vehicle with “+x” going rearward, “+y” going to the curbside and “+z” going up.

The installation model should be built on a skeleton with the primary components tied directly
to the skeleton. Sub-components that attach to a primary component will be mated to that primary
component. For example: a bracket assembly that mounts to the frame will be assembled with
skeleton constraints while the hardware and other components mounted to the bracket assembly will be

mated using assembly constraints to the bracket assembly.
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The skeleton constraint shall be a coordinate system (CS) created for a unique component and
renamed in the model tree as “part number” for that particular component. If more than one
component of the same name will exist in the same skeleton, either rename the CS with the part
number followed by consecutive numbers (part number-2) or if it is a symmetrical application, use -LH
or -RH behind the part number. By constraining the coordinate systems at assembly the component
will be in the correct location in the assembly.

It is essential to have a corresponding coordinate point in the component being assembled to
the skeleton. The desired coordinate system for the component would be the default CSO so that
creation of additional coordinate systems would not be necessary. If a unique coordinate system is
required, rename it as part-number_ASSY_CSYS. The renamed coordinate system identifies that the
coordinate system feature was created for a skeleton assembly and shall not be deleted from the file.
The coordinate system for a component must be made to a feature on the component that is not likely
to move.

The creation of the coordinate system may require additional datum curves, axes, or datum
planes for proper creation. If so, in both the skeleton and the component, rename them so that a
modeler will not accidentally delete them at another time. Other information to keep in mind:

e The skeleton will remain behind the scenes in the drawing and shall not be included in the BOM.

e The skeleton can be either a single model or an assembly of multiple skeletons.

e The skeleton naming convention uses the _skel series and should be related to the assembly for
which it is being created. For Example: the skeleton for 57K2033 is named 57K2033_skel

e Skeletons shall be layered off/hidden so they are not displayed when viewing assembly they are

used in.
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C.12.3 Example of an Installation assembly using Skeletons:

'L'_l 2472885 _RH
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FIGURE 42: 2D CURVES AND CSY'S FOR ASSEMBLY
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FIGURE 43: IMPORTED PHANTOM GEOMETRY
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FIGURE 44: COMPONENT PLACEMENT DIALOG Box
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View of completed
assembly from the
top looking down at
the roadside of the
cab

View of completed
assembly from the
bottom looking up
towards the roadside
of the cab

FIGURE 46: REAR VIEW OF CAB ASSEMBLY
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FIGURE 48: COMPLETED DRAWING - CAB TOP VIEW
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C.13 Installation “Split Balloon” Find Number Technique
C.13.1 Scope

This is the required method of identifying components on an assembly or installation using the
parametric BOM in Creo Parametric. The split balloon has the Find Number on the upper hemisphere
and the Quantity on the lower hemisphere. Within Creo Parametric, the option for this balloon is “with
Qty” when selecting the balloon region. This technique allows components with multiple instances to
maintain the total quantity in the BOM as the balloons are disseminated across the drawing. The
default places one balloon for each find number with all quantities assigned to that one balloon. The
balloons can then be separated between views and pages and maintain the proper quantities for each
balloon in each view or balloon location.

There is a command named split, which means to split the base balloon into separate balloons
and is not to be confused with the term split balloons.

For reference part callouts on an assembly, reference balloons are the required method for
identifying reference components. Use appropriate method to create parametric reference balloons as
required by Creo Parametric. The one exception is if the reference item is from a component not

contained in the Bill of Material, then a flag callout shall be used for reference.

AN

FIGURE 49: REFERENCE BALLOON FORMAT
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C.13.2 Procedure

1. Retrieve the table sbpartslist.tbl (or sbpartslist_spec.tbl) into the drawing.

- Pro/ENGINEER

Sketch Table Format Analysis Info Applications Tools Window FMTV - Mapkeys

IS

o

Insert r Tahle
A Table From File...

&

[Insert & table by retrieving a file from disk. |

3 I

Q0| w

FIGURE 50: STEPS TO INSERT SPLIT BALLOON TABLE

The left
column is for The right
the Find No. column is for
the Quantity
v ‘ | 4
s PART NUMBER DESCRIPTION CAGE CODE
NG A 0Ty
/ PARTS LIST
/ FIGURE 51: SPLIT BALLOON TABLE
The upper The lower
hemisphere hemisphere
identifies the identifies the
FIND NO. Quantity
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2. The Parts List Table will automatically fill out with the contents of the BOM.

20 | 12423650 WASHER, PLAIN 19207
19 3 [2417975-006 WASHER, FLAT 19207
I8 \ 12423649 SCREW, MUSHRGOM HEAD 19207
|7 | 12415338 PANEL, INTERIGR, VEHICULAR, RIGHT SIDEWALL 19207
I6 4 [2414473-011 WASHER, PLAIN 19207
I'5 \ 12418337 PANEL, INTERIOR, VEHICULAR LEFT SIDEWALL 19207
I 4 | |2422875-013 HEADLINER, RH PANEL ASSEMBLY 19207
|3 | 12422875-003 HEADLINER, HATCH COVER ASSEMBLY 19207
|2 \ 12422875-011 HEADLINER, LH PANEL ASSEMBLY 19207
'l 43 |2422873-002 FASTENER, HEADLINER 19207
10 8 12422873-001 FASTENER, HEADLINER 19207
9 2 12422885 DAMPING PAD 19207
8 Il 124186469 RIVET, COMPRESSION 19207
] I8 2422874 CLIP, HEADLINER 19207
b I 6 12422884-002 BUSHING, SELF- LOCHING 19207
5 4 12422884-001 BUSHING, SELF- LOCKHING 19207
4 2 12423075 ANGLE, RETNFORCEMENT 19207
3 2 12422675 TAPE, DOUBLE SIGED BONDING, 940mm LONG 19207
2 4 12422675 TAPE, DOUBLE SIDED BONDING, 8&0mm LONG 19207
I 1 [2414419-076 SCREW, HEX HEAD 19207
FNgD@TY PART NUMBER DESCRIPTION CAGE CODE
FPARTS LIST

FIGURE 52: COMPLETED SPLIT BALLOON BOM TABLE

C.13.3 Split Balloon Callout Generation

The split balloons are created by selecting:

Table > BOM Balloons > Set region > with Qty and select the Parts List table region, and then Done.
Go to the primary drawing view, and on the Tables > BOM Balloon tab select Show and select the
primary view. The balloons show up automatically.

To divide the balloons up into smaller quantities, (while still in the BOM Balloon drop-down
menu) select the split command and select the balloon to be divided, and enter the amount to be taken
out of the total quantity from the base balloon. Then at the prompt, select the new component location
to have the balloon and pick the location for that balloon.

This portion of the procedure is the same for other methods, but the quantity remains visible and

parametric to the system generated BOM table.
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From this point, the balloon manipulation sequences (detach, merge and redistribute) work the
same as other balloon methods.

Example of Split Balloon callouts for the table shown in Figure 53 below:

DRIVER"S 310

(™ waRkED D
-

L]
WARKED s
B
N
P
@ oY
“M?KEDF

B ™ mankeD 84T
3y . EH: WIS
(HE) s
@ PASSLHGER S SIDE '

FIGURE 53: EXAMPLE OF SPLIT BALLOONS ON DRAWING

C.13.4 Split Balloon Callout for Multi-Configuration BOM Report Table

In a Creo Parametric drawing, an assembly drawing format can be modified so the BOM

Report Table reflects multiple configurations of an assembly. This can be based either on family table
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instances or separate assemblies. The preferred method is to create multiple BOM tables with each

instance having its own table.

C.13.5 Split Balloon Callout for Bulk Items

Bulk material items such as convoluted tubing, strip foam seal tapes and other items that are cut to
different lengths and have possible different installed state models but have the same part number need
to be shown in the PARTS LIST TABLE as a single Find Number. In order to do this, several steps are
required, including relations in the PARTS LIST and created split balloons.

1) Parts List Table needs to be set to recursive to the appropriate level
2) The additional Find numbers need to be Filtered out of the Table

3) A relation is written against the Parts List Table to show the total cut length of the bulk
item
4) The split balloons for the filtered find numbers are created (dummy) using the Find Number
of the totaled bulk item still in the Parts List
In the example below, there are several different sizes of convoluted tubing being used and in
multiple quantities. (F/N 41, and 44 thru 49). The lengths of the tubing are also different and the

“shape” of the installed state tubing models are different.

43 | 12420924-008-600 TURING, COMVOLUTED 18207
48 - 12420924-007-503 TUBING, COMVOLUTED 19207
41 | 12420924-006-502 TUBIRG, CONVOLUTED | 9207
48 | 12420924-007-904 TUBTHG, CONVOLUTED 19207
45 | 12420924-005 TUBI NG COMVOLUTED | 8207
44 | 12420824-008 TURI NG, COMVOLUTED | 8707
43 11 |M33367-3-0 STRAF, TIEDOWM, ELEC COMP, ADJUSTABLE, SELF CLINCHING, PLASTIC, TYPE I, CLASS 81343
42 12 |M53367-2-0 STRAP, TIEDOWN, ELEC COMP, ADJUSTABLE, SELF CLINCHING, PLASTIC, TYPE 1, CLASS B1343
4] | 12420924-007 TUBING, CONVOLUTED 19207

FIGURE 54: UNFILTERED BOM FOR BULK TUBING
The PARTS LIST Table was filtered to remove find numbers 46 thru 49, yielding one Find Number
item for each size (dash number) of the convoluted tubing. The total length of the respective tubing

sizes were totaled up in the PARTS LIST for the quantity.

45 |24 IN TUBING CONVOLUTED 19207
44 33 IN TUBING, CONVOLUTED 19207
43 I STRAP, TIEDOWN, ELEC COMP, ADJUSTABLE, SELF CLINCHING, PLASTIC, TYPE I, CLASS 81343
42 12 STRAP, TIEDOWN, ELEC COMP, ADJUSTABLE. SELF CLINCHING, PLASTIC, TYPE I, CLASS 81343
Al |42 IN TUBING, COMVOLUTED 19207

FIGURE 55: FILTERED BOM FOR BULK TUBING

The cut length for each item is identified next to the split balloon at each location in the installation.
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FIGURE 56: BULK LENGTH DEFINE IN VIEWS
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The split balloon callouts for the 41, 44 and 45 find numbers were created with a symbol since these
belonged to the filtered out find numbers. The software cannot generate the balloons for these items so
the balloon symbols have to be used. (NOTE: The symbol may be called BOM_SPLIT_BALLOON
also in the Library)

Custom Drawing Symbol

General |Gmuping I Variable Texd |
— Definition
Symbaol namel SPLIT_BALLOOMN

X

— Preview

Mew...
— Placement
Type I Free j
Mext I-sa-:l-srl j Amowhead || Arow Head j
|
— Properties — Origin
Height % Default

Propartion I  Custom I
Angle II}.DDDDDI} =50 |
Calor %\Q |

0] Cancel

FIGURE 57: SPLIT BALLOON SYMBOL

NOTES:

1) The quantity for each split balloon shall be 1 and the cut length designated either beside or
below the balloon. The reason for this is to clarify the cut length for each item and to insure that

the correct item is used in the designated location.

2) The total length of the bulk material for all locations is indicated in the quantity column in the

Parts List along with the unit of measure as a relation to replace the actual unit quantity.
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bty = "42 IN"
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if final_name == "MS533&7-2-0"
bty = "12"
else

p Local Parameters

FIGURE 58: RELATIONS FOR THE CUT LENGTH IN THE PARTS LIST

C.13.6

Empty Table Space — Removing Part #

When a part is removed from a PARTS LIST and not replaced with an equivalent part, the find

number for where the part was removed shall be replaced with an empty table space. To achieve

this, use one of the ten available empty_table space #.prt parts located in the Standard CAD

Template Library / Start Parts and Formats. The empty table_space_#.prt model is a bulk item

and a relation will have to be written in the parts list on the drawing as shown below:

if asm_mbr_name == "EMPTY_TABLE_SPACE_1"

final_name =

tqty =
endif
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C.14 Creo Parametric pen table settings (default)
See FMTYV Creo Parametric Configuration Settings

C.15 PDF print settings
See FMTYV Creo Parametric Configuration Settings

C.16 PM-MTYV Default configuration file settings
See FMTV Creo Parametric Configuration Settings

C.17 Annotation Features

Annotation features E are data features that can be used to manage the model annotation and
propagate model information to other models. An annotation feature consists of one or more
Annotation Elements. Each Annotation Element can contain one annotation item, along with
associated references and parameters. The following types of annotations can be added using the

Annotation element:

e Note

e Symbol

e Surface finish

e Geometric tolerance
e Reference dimension

e Driven dimension with tolerance

C.18 Relations (default)

The relations built into the start part are Feature Relations. The relations can be accessed by
selecting Tools > Relations and then setting the type to Feature and then selecting the default
coordinate system CSO. Table 14, shown on the following page, lists the current state of relations for

the start parts.
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TABLE 13: START PART RELATIONS

C.19 CHECK mapkey

See FMTYV Creo Parametric Configuration Settings document
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C.20 Component Interface functionality

Component interface functionality was added in Creo Parametric Wildfire. They contain a set
of stored constraints and references that can be used repeatedly to place components. Once an
interface is defined and saved in a component, it can be used anytime the component is placed in the

assembly. Placement of components using interfaces allows them to be constrained more efficiently.

Currently Component Interfaces are not defined on any of the parts. If a user needs to assemble the
same component many times they can create a Component Interface on the “In-Session” model. By
adding the Component Interfaces “In-Session” and using it at that time, as long as they don’t save the
component, it will not affect the model. These Component Interfaces can be created in both Part and

Assembly mode.

C.21 AUTO_PART_NUMBER functionality

The AUTO_PART_NUMBER parameter was added recently to the start parts. If the value is
set to YES then the model automatically takes the name of the part and assigns it to the
PART_NUMBER parameter. If it is set to NO then it leaves it empty and the user is required to enter
the value for the PART_NUMBER parameter.

C.22 Item ID

The Item ID is a special feature used for including the ID of the model on the model with a
curve. This special sketched curve feature needs to be handled differently from other curves on the
model. The feature shall be renamed to “ITEM_ID”, and it shall be added to the “ITEM_ID” layer so
that the user can easily isolate this curve feature from others in the drawing. Typically, the Item ID is
isolated in order to be displayed on the drawing while hiding the other datum curves. The ITEM Id
shall be the ACTUAL ITEM ID that would be marked on the part. A sketch feature can be used to get

the text on the drawing.

C.23 Mass Properties — Manual Input
In certain cases it is helpful to be able to enter the mass of a model manually. Typically Creo

Parametric will calculate the mass of the model automatically based on the assigned density and the
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calculated volume. Often times when dealing with purchased parts or where the material properties
aren’t exactly known, it is helpful to be able to add the final mass manually. In order to complete the
task select Edit > Setup > Mass Props then choose Geometry and Parameters as the Source. Then
choose Edit from the Actions area and enter in value for Mass. This value becomes known as the
PRO_ALT_MP_MASS parameter.

a

Source

Geometry and Parameters W
Crigin
Default v

Density

e
(PR T T

Actions
[ Edit... ] [Genemte Hepu:urt...]

FIGURE 59: SETUP MASS PROPERTIES

o

Basic | Center of Gravity | Inertia
Volume:

Surface Area:

Mass: 0. 250000

FIGURE 60: MASS PROPERTIES PARAMETER

C.24 Military parts and Vendor parts

Typically, military parts are recognized by either the name of the file or by having a
CAGE_CODE parameter filled out. Below is a list of typical military part numbers (either 7 or 8
digits in length) they can either have the cage code preceding the name or only as a value for the

parameter.
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o 12XXXXXX

o  116XXXXX

e 87txxxx (top drawing)
o 57kxxxx (kit list)

If it doesn’t meet the above criteria it could be a vendor supplied model; however, there are

exceptions so this will need to be verified.

C.25 Vendor supplied 3D models
The way to handle vendor supplied 3D models has changed over time. It is recommended to
maintain the vendor’s naming convention so when newer models are supplied they can simply be

updated in Commonspace.

A common issue when dealing with vendor supplied CAD models is data transfer.
Transferring 3D solid geometry through CAD neutral translation can cause problems when importing

them into Creo Parametric. Factors that affect the quality of imported data are:

* Original CAD system

* Quality of modeling

* Model accuracy

* Model complexity

* Irregularity of Geometry

* Type of exchange file (IGES, STEP, Neutral, etc...)

3D geometry imported into Creo Parametric for the MTV database shall be converted to solid
geometry. The conversion to solid models helps ensure that proper model display and mass
calculations can be made. If the task of converting the imported geometry from surfaces to solids is
beyond the ability of the modeler then a modeler with the appropriate ability should be tasked with

converting the model.

The neutral file shall be stored in the FMTV Product under the Models and
Drawings/OEM_Models folder in Windchill PDMLink
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C.26 Next Assembly Parameter

There have been issues with the next assembly parameters with some parts that are in
Commonspace. The NEXT_ASSY parameter shall represent the assembly where the part is used. The
problem is mainly found with parts (ex: -001, -501, and -801) where the next assembly parameter has

been filled out incorrectly.

[T] 19207_12222221.ASM FRAME ASSEMBLY
=-{T] 19207_12345678.A5M WELDMENT
-] 19207_12345678-001.PRT |-LEFT PLATE
----- [ 15207_12345678-002. PRT |-RIGHT PLATE
.. 19207_12345678-003.PRT |-CENTER PLATE

FIGURE 61: ASSEMBLY STRUCTURE - NEXT_ASSY

The left-plate, right-plate, and center-plate are the parts that make up the weldment. In some
occasions it has been noted that the NEXT_ASSY parameter for the plates has not been 12345678, it
has been 12222221 (Frame Assy). The frame assembly is the up assembly in which the weldment is
assembled. The plates shall have 12345678 as the next assembly. The weldment shall have 12222221

(Frame Assy) in its next assembly parameter.

If a part or assembly has multiple up assemblies, then the up assemblies are listed in the parameter

numerically.
EXT_ASSY_T 1240111
EXT_ASSY_2 12402222
EXT_ASSY_3 12403333

m
e
1

FIGURE 62: NEXT ASSEMBLY LIST

In situations where there are more than eight up assemblies, do not create additional
NEXT_ASSY parameters. For the drawing, a hex note can be placed in the NEXT_ASSY parameter
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box located in the title block to relate back to the drawing notes. The drawing note will list all of the

next assemblies used.

The next assembly parameter is based on the assembly that a part or assembly is configured
into. A Where-Used Report can be run in Windchill PDMLink to show what assemblies a part or

assembly may be a component of.

C.27 Handling a Cancelled ECP

Occasionally after initiating an ECP that involves changing various parts, drawings, and
assemblies it gets cancelled. When it gets cancelled a concern is what to do with all the changes that
were completed on the parts, drawings, or assemblies. Ideally, all the changes on these objects shall be
deleted or rather the PIV (Product-ltem-Version) of these objects shall be deleted from Commonspace.
Typically a lot of work goes into making these changes, which more than likely will be requested again
in the future, and it is not cost effective to simply delete them. Some guidelines have been set to

dictate how to deal with these objects.

e If the objects are the INITIAL RELEASE or CONVERTED TO PROE SOLID MODEL then

the Release Level shall be set back to Concept and the models shall be left intact.

e If the previous Revision has been promoted through to RELEASED and the changes made to
the objects were minor (i.e. note change, parameter change, etc...) then the objects shall be

deleted from Commonspace.

e If the previous Revision has been promoted through to RELEASED and the changes made to
the objects were major (i.e. major geometry changes, major drawing changes, or anything time
consuming to complete) then the objects shall be set back to Concept or deleted,.

C.28 Keep All Down Parts and Drawing at Same Revision when
Promoting

There have been many issues related to not keeping the same base number components at the
same revision level. The base number refers to the 8 digit number after the cage code and underscore

in the name of the object. The rule is that all components with the same base number must be revised
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when the drawing is revised. If drawing 19207_12341234.drw is being promoted to a new revision
then all models beginning with 19207 12341234 shall be promoted along with the drawing unless
noted on the NOR. An exception is when in the newer revision one or more of the components are no
longer required and those can remain at the previous revision. All of these components shall be related

to the drawing even if there are no views describing the individual components.

C.29 Weldments

All weldment component parts shall follow the -100 naming convention (as defined in Section
3.8) for the inseparable assembly. In addition, the PARTS LIST table for the weldment shall specify
“NON-REPAIRABLE PARTS LIST” (See Figure 63)

5 | [12423058 105 [SUPPORT 19207

! | [12423058-104  |PLATE, TOP 19207

3 > [12423058-103  [RUNG 19207

: 2 124723058102 [UPRIGHT 19207

| | [12423058-101  [PLATE 15207
FIND - \
NO m PART NUMBER DESCRIPTION CAGE CODE

NON-REPATRABLE FPARTS LIST

FIGURE 63: SAMPLE WELDMENT PARTS LIST
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D Procedures

D.1 Creating a new file
The following procedure shall be used whenever creating a new model. This will ensure
conformance to the latest standards and will allow the models to be tracked by Windchill PDMLink.

This is very import in order to avoid any duplication of work.

1. AIlI NEW parts shall be created with the approved FMTYV start parts.
2. All required parameters shall be filled out before checking files into Commonspace
e ECP_ERR_Number is important to know what ECP created the new file

D.2 Family Table Drawing Creation Procedure
D.2.1 Creating the Family Table in the Part:

Create a family table with all of the information required to model the part. Each instance will
need to be given a distinctive name based on the original part number with a 19207 _ prefix. The
part_number parameter shall be added to the family table to correctly show the part number in the
drawing table. Additional parameters may be required to correctly represent the model at different part
levels. Include any technical data using string parameters, i.e.: din_number or thread_size.

Because of issues in the past in using Family Table functionality with Creo Parametric
assemblies it is important to only use them when it makes sense. In order to decide when to use a
family table to aid in building / maintaining many models follow these general guidelines or ask a local
CAD admin or experienced user.

Do NOT use Nested Family Tables ever. They will cause problems with the database

management system.

D.2.2 Auto Fill Instructions:

The family table can be filled out quickly by exporting the data to Microsoft Excel using the

following icon E{ . Use the Fill > Series command to automatically complete column. Make sure
the column to be filled is empty and then highlight the area to be filled. From the top pull down menu

FMTV-MODELING-STD-100T Rev.L Page 113 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

select: Edit > Fill > Series > Set Type to AutoFill and select OK. Once this is complete, the family

table should look like the following figure:

P& Family Table :19207_12345678 |

File Edt Insert Tools |

Lnnk|n;|1azn?_12345s?a j o EEIE i s @ﬁ. ] T
Tupe | Instance Name dz d0 di PART_MUMBER [ DIN_NUMEER
19207 _12345678 1.0 15 20 12345678 1-1.5:2 - blk - 100
19207 12345675-001 20 20 4.0 12345675001 2244 -blk - 100
19207 12345675-002 3.0 25 B0 12345675002 3-256-blk-100
19207_12345675-003 4.0 30 B0 12345675003 438-blk-100

u] 4 ﬁ. Open | Cancel |

FIGURE 64: FAMILY TABLE

D.2.3 Showing the Family Table in the Drawing:

1. Start by creating a table with a header row and one empty row for the first field. Only create
columns for the data that needs to be shown in the table. Some Family Table columns are used

only to model the part and may not need to be shown in the drawing table.

PART NUMBER WIDTH | GEPTH DIN MUNBER

2. Create simple repeat regions in all of the cells:
Table > Repeat Region > Add > Simple in each column, below the title, pick each of the

empty cells twice to create a repeat region.

3. In each column enter: &fam.inst.param.value. :

Enter Text > Report Sym select the cell to enter text fam... inst... param... value
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PART MNUMBER WIDTH | DEPTH DIN MUNBER

fam.inst.param,.vaoljue

4. Add a filter to each of the repeat regions to only show the values intended for that column.
For part number, create the filter: &fam.inst.param.name==part_number.

Table > Repeat Region > Filters > Add &fam.inst.param.name==Parameter Name - Done

- Done/Return.
PART NUMBER WIDTH | DEPTH OIN MUNBER
23456 78-001 2.0 ¢, 0 2-2-4 - blk - 100
23456 76-007 3.0 2.5 3-2.5-6 - blk - 10D
123456 78-003 4.0 3.0 4-3-8 - bIlk - 100

2D Lightweight Backdrop Creation

This process is for creating 2D lightweight backdrops for use in Installation and Assembly

drawings as phantom reference geometry.

Advantages

Dramatically reduce the file retrieval and regeneration time
Geometry is clean (other methods require a substantial amount of clean-up)

No “tag-along” parts (additional parts not used in the installation shall not be part of the
assembly)

Skeletons can be embedded into the backdrops
Clean BOM

Can create a library of standard views

Useful during the design process as well.

Step 1 - Identification
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The following items should be considered when determining what the backdrop geometry will

be composed of:

e Determine the geometry and views necessary for the drawing.

e Build a temporary assembly model or use an existing assembly (using only the components that
will be seen).

e Avoid using any shrink-wraps in the model structure.
e Establish a known coordinate system location:

o For small installations with isolated components (components located in the same
general area), use the interface for the primary component (this method allows for the
lightweight backdrop to serve as a skeleton as well

o For large drawings with components spread across the chassis, use the default
coordinate system (A separate skeleton file for the multiple primary components will be
required and the associated skeleton(s) will require the same coordinate system).

Step 2 - Establish offset coordinate systems

Coordinate System

Reference Geometry

FIGURE 65: ESTABLISH OFFSET CSYS
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Imm x Imm curves on
outboard surface created on
top of Coordinate in the shape
of an “L” to help define
directions in a coordinate
system.

FIGURE 66: CREATE 2 - IMM X 1MM CURVES

—s=p==———— 1.0000

Imm X Imm curves on
datum plane in front of
cross-member

FIGURE 67: ANOTHER 1MM X 1MM CURVE SET

Step 3 — Make DXF files

o Create a new temporary drawing, empty, with a variable sheet size at 1 x 1.
e The format is not required; make the border size small for ease of deletion later.
e The drawing has a base coordinate at the bottom left corner.
0 The location of the coordinate on the drawing will not work for lightweight backdrops

0 The coordinate curves created in the prior step will be used to create the assembly

coordinates in a later step.
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FIGURE 68: CREATE DXF FROM NEW DRAWING
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Step 3a — Make the Views

x|

Categories Wiew display options
\-"!e_w Tipe [T Use parent view stile
Yizible Ares
Scale Dizplay style | Default j
Sections
Yiew States Default |
Tangent edg -
e 2 £ wireframe
ngin Hiddet lime 1 Colors come fram
; Hidden
Aligriment " Yes 7 : * The drawing
& No ihiicgen € The made|
Skeleton model display ‘wieldment xzection display
" Hide " Hide
" Show % Show
Ok | Close I Spply |

g
oo
@ oo [T - T - BN -1
e e o o
R || oem o o o % o

FIGURE 69: CREATE REQUIRED VIEWS FOR INSTALLATION DRAWINGS
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Step 3b — Inspection of Lines

e Notice the hidden lines for the steering gear casing.

e This was an imported model and will not clean up well, so either eliminate from the
assembly or replace with a true model.

FIGURE 70: INSPECT LINES
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Step 3c — Make other Views

e Do not make projected views or auxiliary views; make only one view at a time.

e After each view is created, save as a DXF file, using the -8xx series of names.

€
iy - ]
P
[
¢ 4
e — ] ]
i:n‘- 2 X
Lok pemtrame | G OO O & BT
B
\J e, [
'r_,,. [L;'}-l'ddl
_ | ]
FIGURE 71: MAKE OTHER VIEWS
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Step 4a — Make the Backdrop

e Start a new part file with an appropriate name utilizing the -800 series.
e Import the DXF file: Insert > Shared Data > From File

e Follow all the defaults:

B 1242X%NXE-801 (Active) - Pro/ENGINEER

File Edit Yiew |Insert Analysis Info  Applications Tools Plotting  Window Help FMTY T

T e SR
JDI_'/U - EES‘ENL_J*J@;"‘
g = = — |@lshel..

B | & | @ hore
Show = | Si ﬂ'\ Draft...
m "\;Rgund... [
] 124200<[ 0.0 Chiamfer .
""" g:i Matel 7 Extrude. .. l
o= Matel S [
o= Motez |
= Motel 2weep ’ |
- 3
2= Propri Blend |
..... £ Distit Swept Blend dl
_____ £= DR Helical Sweep |
_____ 5 SIDE <% Boundary Blend. .,
..... F7 TOP Q,j Yariable Section Sweep. ..
""" £7 FROR Madel Datum |
e s;
..... & Insert Cosmetic 2
[ Style.., :
Restylz, ..
F warp..
Independent Geametry, ., >
User-Defined Feature, ..
Fareign Surface, .., :
Shared Data From File...
Advanced 3 Publish Gearmetry. ..
Copy Geometry from Other Model...
Shrinkwrap From Other Model. ..
Merge from Other Model, .,
Cubout From Gther Model, .
Inhetitance from Cther Model, ..
i
FIGURE 72: CREATE BACKDROP PARTS
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Step 4b — Coordinate System

e Create a coordinate system that corresponds to the assembly
e Use the two 2D curves to establish the coordinate
[ J

Rename the coordinate to a common identifier.
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K\g\ /\ \ TOP
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| S Fi & References selection
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Use | CurvesFE(IM...
oot [X x| _Fi
FIGURE 73: CREATE COORDINATE SYSTEM
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Step 5a — Cleanup

- Select the geometry and right click
- Then select Edit Definition

- Another menu will appear

- Click on the arrow and select the 4 lines of
the format and delete them (the arrow will
need to be selected after each line is deleted).

- Clean off any other lines, curves, or text not
wanted in the drawing.
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FIGURE 74: CLEANUP - EDIT DEFINITION

FIGURE 75: DELETE 4 FORMAT LINES
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Step 5b — Line Font

e While still in the edit mode, click Edit > Feature Operations > Modify Line Style and
then change the font to phantomfont and the color to light grey.

e The 2D lightweight backdrop is now complete.
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FIGURE 76: CHANGE LINE FONT
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FIGURE 77: COMPLETED LIGHTWEIGHT 2D BACKDROP

Step 6 — Lightweight Assembly

e Assemble all of the views together to form a 2D model.
e Assemble to the common coordinates

e Save the file with the -800 series naming convention

.

Skeletons can be added to this same model
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FIGURE 78: COMPLETED LIGHTWEIGHT ASSEMBLY

Step 7 - Installation Model

e Add the lightweight backdrop/skeleton models first

e Assemble the components in the assembly

e This is a clean assembly with no tag-along parts, other than a few models with reference
data
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FIGURE 79 COMPLETED INSTALLATION ASSEMBLY

Step 8a — The Final Drawing

e Start the drawing and place views as normal
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FIGURE 80: BEGIN INSTALLATION DRAWING
Step 8b — Drawing Cleanup
e Set the drawing visibility to No Hidden
e Notice the phantom geometry is hidden out
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e Notice the lines of the other 2D views

LY -

O

FIGURE 81: INSTALLATION DRAWING CLEANUP
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Click View > Drawing Display > Component Display
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FIGURE 82: INSTALLATION DRAWING CLEANUP - COMPONENT DISPLAY
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FIGURE 83: INSTALLATION DRAWING CLEANUP -
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Step 9 — Complete Drawing as Normal
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e This works for sections and auxiliary views also
e Write a relation to remove the Lightweight Backdrop / Skeleton assembly from the BOM

e Notice now the SOLID geometry pops out in front of the PHANTOM geometry.

SCALE 14

FIGURE 84: COMPLETED INSTALLATION DRAWING

Backdrop Assembly Structure — Reference Information

The first 15 steps in this section describe the methodology for creating the lightweight
backdrop parts, assembly, and drawing. The method for assembling installation parts in upper
assemblies will be to create two assemblies rather than just one.

e The first will be the base assembly without any backdrop components assembled. (Example:
19207_12345678.asm) This Assembly will be used in upper assemblies so backdrops will not

be visible in these assemblies.
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e The second assembly will be used in the installation drawing and will have all of the backdrop
components assembled to it (Example: 19207 _12345678-800.asm). This Assembly will only
be used in the installation drawing. This will have all the -8xx backdrop parts assembled,
along with the base assembly. The Model Tree would look something like the image below.

(L] 19207_12345678-800.A5M
F-[Cd 19207_12345678.A5M

L[] 19207_12345678-802 PRT

FIGURE 85: BACKDROP ASSEMBLY TREE

e Alternative Technique for Installation Drawings: In lieu of creating a -800 assembly, the
user can also just create the base installation and use simplified reps to control the -800 series
parts. The -800 2D/3D backdrops are still required in this method, but a standalone -800
assembly would not be needed. The technique for this would be to update the DEFAULT_REP
in the model, so all the -800 parts are excluded from the DEFAULT_REP. This method shall

only be used when the backdrop parts are small in size (< 2mb).

Things to keep in mind while working with Backdrop models

e |f the -8xx backdrop parts are too small for the model; the easiest way to get it to the correct
size is to modify the units. First, change from Metric to English while doing an INTERPRET
dimensions. Then, change back from English to Metric using a CONVERT dimensions. This

should bring the backdrop part to normal size.

e All 2D backdrop parts shall be LIGHT GREY in line color and PHANTOM in line style.

Using Parts Table in Installation Drawing

If a parametric parts table needs to be shown on the installation drawing, the recursive attribute
option will have to be used on the table to show the correct parts. Select the following commands:
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Table > Repeat Region > Flat/Rec Item and then picking the assembly that needs to be shown (the
base assembly). The -800.asm and the -80x (backdrop parts) will still need to be removed from the

parts table by either manually filtering them out or using a relation to filter them out.

D.4 3D Lightweight Backdrop Creation
This process is for creating 3D lightweight backdrops for use in Installation and Assembly

drawings as phantom reference geometry.

Advantages

e Dramatically reduce the file retrieval and regeneration time
e Geometry is clean (other methods require a substantial amount of clean-up)

e No tag-along parts (additional parts not used in the installation shall not be part of the
assembly)

e Skeletons can be embedded into the backdrops
e Clean BOM

e Useful during the design process as well.

Step 1 - Identification

The first step in this process is to determine the necessary geometry required to create the views
on the installation drawing. This will also require the user to have the necessary assemblies in their
Workspace for reference.
Step 2 — Create independent shrinkwrap model

The first step will be to create a new Creo Parametric part. This part will be given a -801 or
higher number (i.e. 19207_basenumber-801.prt).
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FIGURE 86: CREATE 3D BACKDROP PART

Step 3 — Create Shared Data Feature

Select Insert > Shared Data > Shrinkwrap from the Creo Parametric main menu as
shown below.
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FIGURE 87: CREATE SHRINKWRAP FEATURE
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Step 4 — Select Reference Model

From the Creo Parametric Dashboard open a model which geometry will be copied

| <] =

Reference: Options  Properties
| |' Select 1 item

2 Select or open a reference madel

s

=15

|Open a model which geometry will be copiedi

Open a model which geametry will be copied

FIGURE 88: SELECT SHRINKWRAP REFERENCE MODEL

Select the model (part, assembly, or sub-assembly) to create the shrinkwrap from then select
open.
x|
Lxn[zinec] © M NOCE E 3 [BE 9007 @ B 4P

() 19207_12488511-139 pit
() 19207_12458511-140 pit
(1 19207_12486511-141 pit
[0 19207_12486511-142 pit
[0 19207_12486511-143 pit
[0 19207_12486511-144 pit
[0 19207_12486511-145. pit
[0 19207_12486511-146.pit
[0 19207_12486511-147 pit
[0 19207_12486511-148 pit
[0 19207_12486511-149.pit
[119207_12486511-152 ot
[0 19207_12486511-153.pit
[0 19207_12486511-154.pit
[0 19207_12486511-155.pit
[ 19207 _12488511-157 pit
[ 19207 _12486511-158pit
[ 19207 _12486511-159.pit
[ 19207 _12488511-160.pit
[ 19207 _12488511-161 ot
[ 19207 _12486511-162 pit

(C113207_12486511-163.prt
[C113207_12486511-164.prt
[0 19207_12486511-165.prt
[ 13207_12486511-166.prt
[113207_12486511-167.prt
[113207_12486511-168.prt
[113207_12486511-169.prt
[119207_12486511-170.prt
[119207_12486511171.prt
[119207_12486511172.prt
[119207_12486511173.prt
[ 119207_12486511-174.prt
[113207_12486511-175.prt
[119207_12486511-176.prt
[0 19207_12486511177 prt
(7119207 12486511178 prt
(7119207 _12486511-179.prt
(71 19207_12486511-850.prt
2436571, asm|

L4 [+

Namel"511‘

Type | Pro/ENGINEER Files = | Subiyne [ =l
Open I Open Rep... | Cancel | Preview »>>

FIGURE 89: CONFIRM REFERENCE MODEL SELECTION
Step 5 - Locate the model
Define the placement by using the ACSO or CSO of the selected model and the CSO of the
new part (-801, etc). Select the OK button.

Step 6 — Choose proper Pro/ASSEMBLY options

FMTV-MODELING-STD-100T Rev.L

Page 136

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED

13 February 2014



Select the Options tab from the Creo Parametric Dashboard
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— Subszet Options
% Shrinkwrap and select
" Select and shrinkwrap

— Guality

Lewvel: H

— Altributes

I™ it Hale Filling
[ Include Quits
[~ Ignore Small Surfaces
Threshold as percentage of model zize: lﬂ

[Bf References | Options Properties

| [ 79207_12486511 ASM

P Ej Subset

FIGURE 90: CHOOSE APPROPRIATE OPTIONS

Step 7 — Choose Quality Level

Set the quality level (Note: shrinkwraps may require this level to be adjusted until the model’s

appearance is acceptable. A level of one creates a smaller sized file and the higher the quality level

setting the larger the model size). Most shrinkwraps will fall between a quality level range of 3 and 7.

angw T aswngs T

|
UNIT WEIGHT [Feal

] 19207_BASENUMBER-8C
/% MoteD_DESIGN_INTE
“ Naotel
“ Nate2
5 Note3
“ Noted
“ Noted
“ NoteB
“ Nate?
“ Proprietary_Mote
“ Distribution_Mate
-5 DRW_NOTE
-7 SIDE
-7 TOF
£ F FRONT
-2« 50
IETE rtemal Shiinkwrap i
& |nsert Here

0.000000

sIDl
TOF
FRC
Cs0

FIGURE 91: VERIFY REQUIRED GEOMETRY IS PRESENT

Step 8 — Toggle shrinkwrap to Independent
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Make the Shrinkwrap Independent by performing an edit definition on the external shrinkwrap
feature and removing the check from the dependent option.

| 110l
— Subszet Optiohs

[ Dependent
% Shrinkirap and select :
{7 Sielect and|shiinkwiap M
— Guality
Level: IE 3:
— Attibutes

[ Auta Hole Filling
¥ Include Guilts

™| lgnore Small Sufaces

P I Threshold ag percentage of model zize: ID 3:

References | Options  Properties

|| 19207 _12436511.45M = i subset

FIGURE 92: TOGGLE OFF ""DEPENDANT"" OPTION
The result will be a “stand alone” 3D model that is ready to insert into the installation and referenced

by the installation components.

Step 9 — Change the color and appearance of backdrop model(s)

1. Assign colors and appearances to objects

[E 19207_BASENUMBER-800 Rev: ///0 (Active) ilws://if

File Edit |¥iew Insert aAnalysis Info Applications Tools Plotting  Windo

J B = [2] Repaint Cir+R E % gg ﬂi—‘ Wy
4 Shade
g"’ %l Render Window
Shaw ™ | Realtime Rendering
Orientation 4
[ 19207 _E o
..... £ Note Wisibility »
..... r= Note,  isplay Style »
= Mote.  REpresentation 3
Mate  Substiute »
Flop  Explode »
Dristri

DR I3 View Marager
""" == Note T Envelope Manager

""" 5 Note @ Color and Appearance I
= Motk
" Model Setup 3
Mote_ ~  lassign colors and appearances to objects)
REY.  Layers..
REY,
= REY  Display Settings »

..... “ REV_A_DESC_GH7 I e

FIGURE 93: ACCESS APPEARANCE EDITOR
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2. Select the color grey

¥ Appearance Edib®

Eile Material Options ‘

C06o -
Heé6e -
0960 .

| gray

FIGURE 94: SELECT GRAY COLOR

3. Assign the color to the backdrop models > OK button > Apply button

| Eompo_nents ¥ [

% cea

apply_| FiomModsl |

| Basi | Map | Advanced| |
Color - |
ol T |

FIGURE 95: SELECT GEOMETRY TO APPLY COLOR

4. Set the following properties: Matte=0.00, Transparency = 80.00 and select the Close button

FMTV-MODELING-STD-100T Rev.L Page 139 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

FIGURE 96: SET TRANSPARENCY

The model should now look like the following image:

FIGURE 97: RESULTING 3D BACKDROP
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The “backdrop” models are to be transparent instead of the 2D geometry representations. This
is a 3D backdrop not a 2D backdrop method. The structure in the model tree remains the same as with

the 2D backdrop method, as shown below.

The note named NoteO DESIGN_INTENT should be used to document the name of the
assembly used to create the shrinkwrap model. In the future when changes occur this information will
assist in updating the shrinkwrap model. The user can check-out the reference assembly, toggle the
shrinkwrap as DEPENDANT, update the shrinkwrap, and toggle back to INDEPENDENT.

[T] 19207_BASENUMBER-E00.45M
----- £ Natell_DESIGN_INTENT

----- “= Note2 Installation
=N Assembl
Note0 DESIGN_INTENT |~ B Propristary_Note Y

----- FE REV_A_ZONE_SH1
----- FE REV_A_DESC_SH1
----- FE REV_A_ZONE_SH7
----- FE REV_A_DESC_SH?
----- £E REV_A_ZONE_SH2
----- FE REV_A4_DESC_SH2
----- FE REV_A_ZONE_SH3
----- FE REV_A_DESC_SH3
----- FE REV_A_ZONE_SH4
----- £ REV_A_DESC_SH4
----- FE REV_A_ZONE_SHS
----- £E REV_A_DESC_SH5
----- FE REV_A_ZONE_SHE
----- FE REV_A4_DESC_SHE
----- £7 SIDE_&SSY

..... £7 TOP_ASSY 3D Shrinkwrap

..... /7 FROMT_ASSY component
-2y ACS0 P
-2 12486511_C5Y'S

B[] 19207_BASEMUMBER-801 PRT

[T 19207_BASENUMBERLASM

----- /7 ADTHI
""" 7 XSEC-E_DTM
----- /7 ADTME

----- % |nzert Here

FIGURE 98: FINAL MODEL TREE

The assembly of solid components must be separate from the models used to make the
backdrop. In this case 19207_BASENUMBER.ASM shall be used in the next level assembly without
bringing the back drop models along. Also, the backdrop models must me completely independent

from the models they are created from.
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Step 10 — Drawing Settings for 3D backdrop parts

The line type for 3D backdrops shall be PHANTOM. The color of the lines on the 2D drawing

will relate to the system settings for shrinkwraps.

Note: These steps were defined with Pro/ENGINEER Wildfire 2.0 and there
may be slight menu differences in subsequent versions of Pro/ENGINEER.
The concept should remain and slight adjustments should be manageable by
users familiar with Pro/ENGINEER.

3D-Backdrop Creation Checklist / Reference Guide

1) Checkout the required components for the 3D Backdrop into a clean workspace.

2) Create a temporary assembly to assemble the required backdrop components. An existing assembly could
be used but to avoid accidental check-in of the assembly, it is recommended to create a temporary
assembly. The assembly should be built to the VCS (Vehicle Coordinate System) for Chassis installations
and CBCS (Cab Body Coordinate System) for Cab installations.

3) After the model is complete, export as a solid IGES file using either the VCS or CBCS as the assembly
reference point. Be sure to make the file SOLID and FLAT in the selection menu.

4) Open a new file for importing the IGES file using the desired name for the 3D Backdrop. Create a VCS
coordinate system as defined in the VCS portion of the Standard.

5) Import the solid IGES model using the default coordinate system — which is the VCS embedded in the IGES
file and the VCS created in the new part.

6) Save the file before continuing

7) Run the FXLA mapkey to fix the layers and remove the IGES imported layers.

8) Assign the material property to NONE_V1 and set the Mass Properties density to 0.0001. Write the relation
“unit_weight=pro_mp_mass” under the CSO. These settings will make sure the 3D backdrop does not
generate a mass that will drive the weight parameter on the drawing.

9) Edit the component parameters list.

10) Apply the 3D backdrop display settings IAW the CAD Modeling Standard

11) Run the Model Check and correct any errors

12) Start a dummy drawing and place the 3D backdrop into the drawing in several different views (3D, front,
side..) and verify that the viewing requirements are met.

13) Do not check in the dummy assembly or the dummy drawing.

14) Save the 3D Backdrop file and check into Windchill PDMLink.

Suggestions for a clean 3D backdrop model:

e Do not include hardware (bolts, nuts, washers ...) in the model because these will make the export
model very large.

e Components not seen in any of the views on the drawing should not be shown. The idea is to make a
simple backdrop for orientation of the components installed on the vehicle. The more “stuff” in the
backdrop the larger the file will be.
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o Remember that the lines will be in phantom so the lines will be broken up. Very small parts will not be
entirely discernible so eliminate them from the backdrop unless absolutely required.

o Pay attention to the SCALE that the drawing will be presented - that will help determine what needs to
be in the backdrop model.

Possible issues:

o If there are purple line elements in the drawing then there was an unresolved surface in the IGES file.
One way to fix this is to make a STEP file of the component before assembling it into the dummy file.
Make the IGES file again and verify that the purple entities are white.

o If the file is too large or takes too long to load, reduce the number of components and remove hardware.
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The following four tables list items and directions in order for checkers to perform their tasks.
The four checklists include CM Checklist, Standard Model Checklist, 2D PDF Drawing Checklist, and
Vendor / Legacy / Standard Model Checklist. These four checklists were originally separate

documents but were recently combined and added to this document for reference purposes.

CM CHECKLIST

current rev of the Creo Parametric drawing.

Item TAC | CTR Comments
Note contents of Change Notice. X
Open Creo Parametric drawing. X
Print PDF released drawing in PDMLink and X

Paper-to-paper comparison of PDMLink
drawing previous rev to current Creo Parametric
rev. Document any differences on NOR.

Rejection item: Undocumented differences between
X approved CMSTAT drawing and new Creo
Parametric drawing.

Drawing Check

Open Creo Parametric drawing & perform
Model Check.

X Rejection item: Model Check failed.

Check rev. block for correct history, rev. level &
ERR numbers.

Rejection item: Rev. block has incorrect information
/ Rev. block history is incomplete / Rev. level is
incorrect / ERR number is incorrect.

Rejection item: Title block has incorrect information

Check title block. X / Text is outside of format boundary.
Check rev. levels on all documents X

No layering standard for drawings. Make model
Check that drawing displays properly. X dependent on model layers instead of drawing

layers. Do not reject due to problem with archived
part/assy since nothing can be done.

General feature check.

X Check that holes are features, not sketched lines, etc.

completely.

2nd Check
Check that rejected items are fixed. X
If 5 items were rejected previously, recheck X

Double check that rev. block is correct.

Rev. history ERR numbers may have updated
incorrectly.

TABLE 14: CM CHECKLIST

STANDARD MODEL CHECKLIST

Item TAC | CTR Comments
Note contents of Change Notice / Promote. X
Check Change Notice / Promote to determine if
NOR is needed. If there is no NOR, search X NOR is not required for initial release or the first
PDMLink for previous rev. (NOR is required if time an object is placed in PDMLink
previous rev.)
Check that only one drawing is attached to RTP. X Reject if more than one drawing is attached to an
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RTP.

Run Where Used report on each part/assembly being

promoted. Check that next up assemblies at release Rejection item: Components do not assemble

level Preliminary Release or higher regenerate before X correctly in assembly.
promoting part or assembly to Preliminary Release.
Promoting Assemblies: All subordinate items must
be at the same or higher release level than the X
assembly being promoted.
Create a workspace and check out RTP contents. X
If no drawing is present, check for PDF drawing. X Make sure drawing or PDF drawing is attached to
package.
Print the NOR. X If needed.
Print the PDF Drawing. X If needed.
X If Needed
Print out released Drawing & current rev. of Creo X
Parametric Drawing.
Check that all parts/assemblies/drawings are named X X (Stds. Para. 3.8/4.5/5.15) Will be confirmed by

correctly ModelCHECK only.

Paper-to-paper comparison of the released drawing

. . X Any differences must be documented on NOR.
previous rev. & current Creo Parametric rev.

See Attachment A. Reject if any parameters have

Check parameters in PDMLink X : L
incorrect/missing values.

Drawing Check

Open Creo Parametric Drawing: Perform Model Verify no errors or valid warnings exist. (Stds.

Check at the beginning and end of the check. X Para. 2.10.1)
ERR number should be correct / Rev. history and
level should be correct / Format should be correct /
Check rev. block. X

Line format color should be correct / Text should
be correct size and color.

Check that correct distribution statement is located at

the bottom of every drawing sheet X Dist. Statements A, B, C, D, and X can be used.

Check that correct EAR or ITAR statement is located X Only Dist. Statements B, C, D, and X require an
in the bottom left hand corner of each sheet. EAR or ITAR statement.
Revision block has been updated as appropriate X Stds. Para. 5.11
. Check that text does not exceed format boundary /
Check title block. X Verify title block information. y
Exceptions, notes, BOM Table, symbols etc.
Check that entities are related to appropriate view. X X should be related to correct views or host entities.
(Stds. Para. 5.7)
Verify correct line weights/colors. X X Stds. Para. 5.8
No layering standard for drawings. Make model
. . dependent on model layers instead of drawin
Check that drawing displays properly. X Ia;)ers. Do not reject dﬁe to problem with arc%ived
part/assy since nothing can be done.
Notes should be driven from model. Most or all
Switch Dimensions to check that dims, notes are dimensions should be driven from model (not
driven from the model, thus verifying that they are X created). Stds. Para. 5.1 This will not be checked.
parametric. (Exception: Preliminary) However, overridden dimensions (@o) can be

rejection items on a case by case basis.

Parameters and notes originate from the drawing

X Stds. Para. 4.3 & 5.13
model.
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GTOLs attached to base dimensions, datum planes or
Stds. Para. 5.2
surfaces, not unattached notes.
Verify correct text height. X
Verify note contents & spelling. X
Verify that all dimensions & geometric features are X
displayed.
General feature check. X gtrgeck that holes are features, not sketched lines,
Verify all required geometric tolerances and datum Verify during visual check of drawing only - not at
references exist. the part/assy levels. (Stds. Para. 3.2)
Parts contain curves or box with note reference to Verify during visual check of drawing only. (Stds.
represent part number (if necessary). Para. 3.1.1/4.1.1/4.2)
\I,DJ?S\?QQQ Revision is 1 higher than currently released If revising current drawing. (Stds. Para. 2.8.2)
All drawing deficiencies in TVPDMS have been
resolved and the drawing conforms to the resolutions Stds. Para. 2.2
when applicable. Outstanding ECPs have been ' T
investigated.
All differences between new & old drawings have
been documented by NOR. Stds. Para. 2.8.1
A visual check (comparison) of new & original
drawing has been completed and all required Current drawing conversions only. (Stds. Para.
information has been accurately transferred to the 3.1.21)
new drawing.
Part Check
Perform Model Check at the beginning and end of the check.
Run Model Player. X Force regeneration.
Check layers and their status. X
Check Item ID layer. X
Check that correct distribution statement is located in .
the model tree labeled "Distribution_Note" X | Dist. Statements A, B, C, D, and X can be used.
Check that correct EAR or ITAR statement is located X Only Dist. Statements B, C, D, and X require an
in the model tree as a note. EAR or ITAR statement.
Verify all geometric tolerancing datum planes are on
the G DTM_PLANES layer. (Stds. Para. 3.11)
Check part specific notes. X FMTV Tools - General Note Editor is available.
Check Model Tree for "Note 0" / Suppressed X
Features / "DWG_NOTE"
Check defined material and material note 2. X They should be the same.
Dummy material callout not allowed. All
Check material callout. X appropriate material files must be assigned to part.
Primary material file is current. (Stds. Para 3.3)
Check units (must not be Newtons) X M(_)del units and Windchill PDMLink parameter
units must be the same.
Check parameters for omissions or value errors. X See Attachment A.
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Check for weak dimensions. X No weak dimensions allowed.

Remove any old "Standard Relations" and verify

Check relations. X .
proper comment lines.

Check that holes are features, not sketched lines,

General feature check. X
etc.

Verify part modeled matches latest released
revision of drawing. Outstanding ECPs have been
X X investigated. All drawing deficiencies in
TVPDMS have been resolved and part conforms
to resolutions when applicable. (Stds. Para. 2.2)

Verify that the part is representative of physical
characteristics of real part.

All features in the original drawing must be included

in the model. X Stds. Para. 3.1.1
Check 3D note naming and contents X IAW Standards Para. 3.5
The part regenerates without failure or external input X Stds. Para. 3.1.3

required.

Assembly Check

Perform Model Check at the beginning and end of the check.

Run Model Player. Force regeneration.

Check layers and their status.

XX | X

Check Item ID layer.

All geometric tolerancing datum planes have been

added to the "G_DTM_PLANES" layer. X Stds. Para. 4.7

Check part specific notes. X FMTV Tools - General Note Editor is available.

Check Model Tree for "Note 0" / suppressed features
/ packaged components / "DWG_NOTE"

Check that correct distribution statement is located in

the model tree labeled "Distribution_Note" X Dist. Statements A, B, C, D, and X can be used.

Check that correct EAR or ITAR statement is located Only Dist. Statements B, C, D, and X require an
in the model tree as a note. EAR or ITAR statement.

All assembly parts must have a cage code.
Assembly cannot be promoted to Preliminary
Check for Ref. parts (no cage code). X Release until all down level parts and assemblies
that are not part of the current ECP are at release
level Released.

Check parameters for omissions or value errors. X See Attachment A.

Check for weak dimensions. X No weak dimensions allowed.

Remove any old "Standard Relations™ and verify

Check relations. X )
proper comment lines.

Verify the /* has been removed from the (Stds. Para. 3.12.4) Check by confirming

UNIT_WEIGHT=MP_MASS("") code line. X Unit_Weight is appropriate.
General feature check. X gtr;eck that holes are features, not sketched lines,
L . Rejection item: Checking is being stopped at this
If 5 rejection items are found, stop checking and X point. 5 Checklist items have been discovered
return to sender. s e . . A
with invalid information. Entire package is being
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rejected. Please review all objects according to
TACOM BULLETIN-CHECKLIST-100

The only notes to be verified in down level parts
will be Note#1 (standards/specs) and the material
X note for the specific part. (EX: Assembly material
Note#6 does not have to be in Part Note#6 -> Part
note may be #2, etc. (Stds. Para. 3.5)

Check that parts of a weldment or assembly contain
all part specific notes.

Outstanding ECPs have been investigated. All
Assembly modeled matches latest released version of drawing deficiencies in TVPDMS have been

the drawing. resolved and assembly conforms to the resolutions
when applicable. (Stds. Para 2.2)

All parts in the original drawing are included in the
model and for assemblies, that all parts are
assembled correctly. (Ex: make sure that -001 part is
not assembled for a -002 part)

This is confirmed during visual comparison
X between drawing and assembly model. (Stds. Para
4.1.1)

All assembly features are present, are truly assembly This item should not be checked, per decision at

features, and should not be part features. X January 2004 IPR. (Stds. Para. 4.1.3)

The assembly of the model follows a logical X This will not be checked. (Stds. Para 4.1.2)
sequence.

The assem_bly regenerates without failure or external X Stds. Para. 4.1.4

input required.

Verify 3D note naming and contents. X IAW Standards Para. 4.3

No packaged components unless appropriate. X Stds. Para. 4.1.5

Voting Notifications

Rejections Note: After voting to reject an RTP, all RTP items must be locked and transferred back to the originator.

Voting: After voting, send an email notification to
the originator.

X Rejection notification or Approval Notification.

2nd Check
Run Model Check.
Run Model Player. X
Check that rejection items are fixed. X
Double check that rev. block is correct. X Rev. history ERR numbers may have updated

incorrectly.
Windchill PDMLink
All required parameters have been correctly entered.
Drawing, Part, Assembly & PDMLink parameters X Stds. Para. 2.8.1
are set to the correct (& same) level.
Unit_Weight is appropriate for parts & assemblies. X Stds. Para. 3.12.4
X Stds. Para. 2.10 — Not required

NOR doqument is filled out and related to the Creo X Stds. Para. 2.10
Parametric drawing as attachment
All parts defined by a drawing are related to the
drawing even if they are not used in a view on the X Stds. Para. 5.12
drawing. (Ex: -500, -800 part)
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Drawing is promoted in accordance with the current
release procedure document.
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Stds. Para. 2.10

TABLE 15: STANDARD MODEL CHECKLIST

2D PDF DRAWING CHECKLIST

Item TAC | CTR Comments

Note contents of RTP. X

X | Reject if QA document is attached to RTP.

X
Check that only one drawing is attached to RTP. X E_erjsct if more than one drawing is attached to an
Create a workspace and check out RTP contents. X dcrgi\(/;il;;hat QA Comments sheet is attached to
Print the NOR. X If required.
Print the PDF Drawing. X
Update QA Comment form to reflect contents of RTP. X If required
Print out released Drawing previous rev. X
Check that PDF drawing is named correctly. X X | (Stds. Para 5.15)

PDF/2D Drawing Check

Paper-to-paper comparison of the CMSTAT previous
rev. & current PDF rev.

Any differences must be documented on NOR.

Verify that all changes listed on NOR have been
incorporated on PDF drawing.

X

Check parameters in PDML.ink

X

See Attachment A. Reject if any parameters have
incorrect/missing values.

Voting Notifications

Rejections Note: After voting to reject an RTP, all

RTP items must be locked and transferred back to the X
originator.
Vc_)tl_ng: After voting, send an email notification to the X Rejection notification or Approval Notification.
originator.
2nd Check
Check that rejection items are fixed. X
Do not need to do a full check of everything. X Unless 5 items were previously rejected, then

recheck completely.

TABLE 16: PDF DRAWING CHECKLIST
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VENDOR/LEGACY/STANDARD PART MODEL CHECKLIST

Item TAC | CTR Comments
Note contents of RTP. X
Check RTP to determine if NOR is included. If there is
no NOR, search Pro/INTRALINK for previous rev. X
(NOR is required if previous rev.)
Check that only one drawing is attached to RTP. X aR:JSE:rtP'f more than one drawing is attached to
Run Where Used report on each part/assembly being
promoted. Check that next up assemblies at release level X X Rejection item: Components do not assemble
QAL or higher regenerate before promoting part or correctly in assembly.
assembly to QAL.
Promoting Assemblies: All subordinate items must be at
the same or higher release level than the assembly being X
promoted.
Create a workspace and check out RTP contents. X dcrgis:(n;hat QA Comments sheet is attached to
If no drawing is present, check for PDF drawing. X Make sure drawing or PDF drawing is
attached to package.
Print the NOR. X If needed.
Print the PDF Drawing. X If needed.
Update QA comments form to select contents of RTP. X
Print out CM-Stat Drawing & current rev. of Creo X
Parametric Drawing.
Check that all parts/assemblies/drawings are named X X (Stds. Para. 3.8) Will be confirmed by
correctly ModelCHECK only.
Paper-to-paper comparison of the CMSTAT previous X Any differences must be documented on
rev. & current Creo Parametric rev. NOR.
Check parameters in PDMIink. X ﬁee Attachment A _Reject if any parameters
ave incorrect/missing values.
Part Check
Run Model Player. X Force Regeneration.
Check parameters for omissions or value errors. X See Attachment A.
Verify part modeled matches latest released
revision of drawing. Outstanding ECPs have
Verify that the part is representative of physical X X been investigated. All drawing deficiencies in
characteristics of real part. TVPDMS have been resolved and part
conforms to resolutions when applicable.
(Stds. Para. 2.2)
Part regenerates without failure or external input X Stds. Para. 3.1.3
required.
Voting Notifications
Rejections Note: After voting to reject an RTP, all RTP
items must be locked and transferred back to the X
originator.
Voting: After voting, send an email notification to the X Rejection notification or Approval
originator. Notification.
Verify that part can be assembled into next higher X
assembly.
2nd Check
Run Model Check. X
Run Model Player. X
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Check that rejection items are fixed. X
Do not need to do a full check of everything. X Unless 5 items were previously rejected, then
recheck completely.
Double check that rev. block is correct. X Rev. history ERR numbers may have updated
incorrectly.
Windchill PDMLink
All required parameters have been correctly entered. X
If values are known, enter the following
parameters: PART_NUMBER,
. DRAWING_NUMBER, CAGE_CODE,
T oy L e models 1SS ||| NOMENGLATURE, UNIT WEIGHT
' MODEL_REV, MODELER_NAME _1
(modeler name can be the company that
supplied the model).

TABLE 17: VENDOR / LEGACY / STANDARD PART MODEL CHECKLIST

D.6 Procedure for Promoting Objects to a new Revision
e Check out everything with the same base number (e.g. 19207 _12421234.drw where 12421234
is the base number). An exception is when in the newer revision one or more of the components

are no longer required and those can remain at the previous revision.
e Modify everything with the same control number.
e Change the following attributes:
0 VERSION - revision on ECP
0 RELEASE_LEVEL - In Work
0 ERR_ECP_NUMBER - the current ECP number
0 ERR_ECP_APPROVER - replace current name with name of approver
0 ERR_ECP_DATE - replace current date with YY-MM-DD (to be changed later)
e Check the Objects into Commonspace
e Windchill Parts and Drawings shall also be revised at the same time.

e Refer to PDMLink User Guide for a Step by Step Guide on how to Promote Objects
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D.7 Superseded and Obsolete Parts

A superseded or obsolete part should not be modeled. The main goal is to model only active
parts on a drawing, thus superseded/obsolete are not needed. If the drawing has both superseded and
active parts, only model the active parts. The following is only if the drawing has not been

converted to Creo Parametric.
How this is handled:
e Remove the Superseded / Obsolete part from the drawing

e If the Superseded / Obsolete part is on the sheet before the production / active part, move the

production / active part to the earlier sheets and remove the extra sheets.

e Update Part Tables (If any) to the superseded parts to say REMOVED AT REV (X) either in
the SHEET column or in the DESCRIPTION column.

FROM:
TABLE
PART NO. SHEETS COMMENTS
12417336 | SUPERSEDED BY 12417336-001
12417336-00| 2 SUPERSEDES 12417336
TO:
TABLE
PART NO. SHEETS COMMENTS
12417336 REMOVED AT REV.E [SUPERSEDED BY 12417336-001
[2417336-001 | SUPERSEDES 12417336

FIGURE 99: FROM-TO EXAMPLE
e Document all changes as normal in the NOR, including removal of sheets, updating of tables,

moving the production/active part to earlier sheets, etc.

If the drawing is completely obsolete (no active parts on the drawing), do not model that part or

drawing. If for some reason the models are required it can be modeled, but that should be a rare case.
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If the drawing has already been converted to Creo Parametric and a future revision will
supersede / obsolete a part on the drawing, the model shall NOT be removed from the drawing. This

will allow the user to leave the models on the drawing and not have to shift around multiple views.
D.7.1 Superseded and Obsolete Parts — Revision Block

The revision block shall conform to the ASME Y14.35M standard. In addition, if a part is
superseded by a new drawing, place a marking above the Title Block that states SUPERSEDED
BY 12XXXXXX (part number) in a balloon as depicted in Figure 100

///—‘\u/ R\\\,/ ‘A\\//k\\\\f\
4

( SUPERSEDED BY 12567890 /

(

THIS DRANING WAS GENERATED FROM A SOLID MODEL
AND 1S CAD MAINTAINED. CHANGES SHALL BE
INCORPORATED BY THE BESION ACTIVITY.

IPART NO. 12345678 |

WOT NUMBER DESIGN ACTIVITY U5 ARMY
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FIGURE 100: SUPERSEDED CALLOUT

D.8 Labels and Nameplate Modeling Procedure

All labels and nameplates (placards) are to be created and maintained in Creo Parametric.

D.9 Installation Drawings/Assemblies
All installation drawings/assembly models shall contain a Vehicle Coordinate System (VCS) for ease

of assembling to Chassis and Top Level models (Refer to Appendix E).
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E Vehicle Coordinate System

E.1 \ehicle Coordinate System (VCS)
Note: The VCS listed below for FMTV was established for the FMTV A1P2 variant. The information

remains for historical purposes only.

The VCS is the driving base coordinate system for all FMTV trucks. The VCS is established by the
intersection of the 3 Planes representing the length, width and height of the truck; X, y and z
respectively. The 3 planes coincide with the axis through the E Datum hole on the frame rails for the X
axis (length) and the Z axis (height) and the centerline of the vehicle for the Y axis (width). The E
Datum lines up with the theoretical centerline of the front axle and establishes the F Datum at the
opposite end of the frame rail which lines up with the rear axle/trunion centerline. The frame rail
dimensioning scheme is based on the E Datum and all hole features are constrained back to the E
Datum. This is the same for all frame rails (roadside and curbside) therefore this is the logical location
for the VCS. The right hand rule establishes that from the VCS, the X is positive rearward, Y is
positive towards the Curbside and Z is positive vertically. This coordinate shall be included in all
Installation assembly models and named as VCS. As a default, the intersection of the Front, Side and

Top planes establish the X, Y and Z planes respectively.

-
(@124 [r-Alo]axs 60 ] ’;

[ [5:0 [ Alolwc (@

FIGURE 101: VCS ESTABLISHED ON ROADSIDE FRAME RAIL
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TOP_ASSY

FRONT_ASSY. / / \

ié VTS

IDE_ASSY

FIGURE 102: VCS IN DEFAULT VIEW

In “default” view orientation, the VCS is established at the intersection of the three default assembly

datum planes. Notice the orientation of the X, Y and Z datum references. This is essential that they are

oriented in this manner or the whole purpose for the VCS is of no value.
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FRONT_ASSY

IDE_ASSY

FIGURE 103: VCS WITH FRAMERAIL

The same default view with the frame assembly added for clarification is shown below.
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\!IDE_ASSY
FIGURE 104: VCS IN DEFAULT WITH FRAMERAIL

For Installations that are created with the VCS in mind, the VCS coordinate as shown is at the

intersection of the default datum planes and the XYZ orientation established as shown earlier. If the

Installation assembly is not built off the default datum planes, then the VCS coordinate can still be

OFFSET by either a set of datum planes, curves, points or by another coordinate system.

Front Cab Mount Installation shown below with the VCS and CBCS (Cab Body Coordinate System —

explained later).
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FIGURE 105: FRONT CAB MOUNT INSTALLATION WITH VCS

The Installation can then be assembled to the Frame assembly by mating the 2 VCS coordinate system

points and it will snap into place as shown below.
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FIGURE 106: FRONT CAB MOUNT ASSEMBLY CONSTRAINT

FIGURE 107: FRONT CAB MOUNT INSTALLED

E.2 Cab Body Coordinate System (CBCS)

The CBCS is the coordinate system for the Cab body and all related installations shall have a

coordinate placed and named as the CBCS. The top level Dressed Cab model shall have the VCS
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included in it as well. The CBCS varies between the different cab designs but it shall be established by
following the same X Y Z relationship and orientation as the VCS.

The location of the LTAS Cab CBCS and the chassis VCS is shown below:

CBCS

FIGURE 108: CBCS OFFSET FROM VCS DIMENSIONS

FIGURE 109: CBCS IN DEFAULT ORIENTATION
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E.3 Roadside (aka RS and Driver Side) and Curbside (aka CS and
Passenger Side)
The “roadside” of the vehicle is the side of the vehicle that is parallel to the road and the “curbside” is

the side parallel to the curb. The usage of Left side and Right Side can be confusing because in
orthographic drafting terms, the roadside view is the right side but WRT vehicular terms, it is left side
because that is how the view is observed by the Driver while sitting in the vehicle. For clarity and

uniformity, roadside and curbside have been designated.
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F  Special Partand Drawing Types

F.1 Standard Parts

Standard parts are components defined by standards organizations and are not under the control
of the Tactical Vehicle (TV) group at TACOM. These would include parts defined by SAE, NAS,
ANSI, and MS to name a few. These parts are modeled as needed and reflect the size shape and
weight of the actual parts. An abbreviated set of parameters is needed for these parts. As these parts
are not controlled by TV, a drawing is not created, and an ECP is not processed. Parts should be
checked by a second modeler to ensure the basic geometry and weight are correct and the necessary
parameters are filled out. The parts can then be promoted directly to the Released state. Care should
be taken in naming the parts. MS35489-23 is not the same as MS35489-023. These parts shall all be
located in the / STANDARD PART LIBRARY / MODELS AND DRAWINGS folder in Windchill
PDMLink and not in the folders where they are used (release procedure issues).

In addition, the Specification Number shall be filled into the SPEC_NUMBER parameter. This
Spec Number shall match exactly what the Spec says. In addition, the spec shall be called out on the
drawing in either the notes section or within the Table (See Figure 110). Users can use table
sbpartslist_spec.tbl in Commonspace. When multiple specs are called out on a drawing, the table

method is preferred.
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IG 2 M351029-51 SSCR-HEX SOC,FL PT ALY STL 0205 NASMS102%
I3 | MS24665-516 PIN, COTTER {SPLIT) BO205 NASMZ4665
|4 | ME51472-01 NUT 96906 MS51472
13 2 M535649-2254 NUT, HEX, I/4-20 UNC-2B BO205 NASM35649
|2 | MS51930-1 FAD EYE 96906 M351930
Il 4 BIS221BHI25W WASHER 80204 ASME BI§. 22|
o 4 BI8Z21BHOGIN WASHER B0204 ASME BI&. 271
9 | MS16842-3 CLAMP,WIRE ROPE/DOUBLE GRIF/THREADED, STEEL 96906 MSI6842
8 | 1636670 BOLT 19207
1 | I 1636668 CABLE 19207
g | 1636665 U-BOLT 18207
5 | 11636591 FAWL ASSY. 18207
4 | 11592666 MEMBER 15207
3 | 1592657 SHAFT ASSY 19207
? £ 11592656 FLANGE 19207
| | 1409903 SPRING  PLUNGER LATCH 19207

FP‘JgDGTY PART NUMBER GESCRIFTIGN CAGE CORE | SPECIFICATION

PARTS LIST

FIGURE 110: SPECIFICATION PARTS KIST

F.2 Common Parts

Common parts are parts that have TACOM (TV) drawings and are used across multiple
systems. They must be released with an ECP. It will be an Administrative 2 ECP (assuming no real
content changed) to speed the process. What makes up a Common part? Items to look for: Does the
drawing contain all the information required to actually manufacture the part? If not, it may be a
common part. Is it an item that is stocked normally (e.g. clamps, bolts, nuts)? Does the drawing
reference other standard part numbers e.g. is there a DIN (or other) part number called out on the
drawing? If the drawing is completely detailed to the point that it could be manufactured from the
drawing, it probably is not a common part. Common parts should be located in the Common_Parts

directory (again release procedure issues).

F.3 Deformed parts

Deformed parts are parts that change shape upon installation. These parts have a couple of
subdivisions that are treated differently. Items that are always deformed fairly consistently upon
installation e.g. pop rivets, lock washers etc. have an uninstalled model(s) named with a —998 (and

lower) for pictorial use on the drawing. The installed versions are created in their deformed state and
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named with the standard dash numbering system. Items with a specific grip range should be modeled
at their maximum grip range. The reason for this approach is to limit the vast number of parts that
would be created if a model had to be created for each possible variation in installation. Items that are
deformed differently upon each installation e.g. hose clamp, springs, etc. will use a —900 series part of
the up assembly. The parameters of the =900 part should reflect the parameters of the up assembly
except for Nomenclature, drawing number and most importantly part number. This method was
implemented when it was discovered that the previous practice of ‘partnumber_in_partnumber’ did not
work if there were dash numbers in both part numbers. This workaround may be able to be eliminated
in future versions of Creo Parametric. Flexible components are still the preferred method in lieu of

creating a -900 series part.

For example:

MS21266-2N (Grommet, Plastic, and Edging) is an item that is used in many assemblies and is
deformed differently each time. Let’s say it is used in an assembly 12345678. The file name for the
grommet used in this assembly would be 19207 _12345678-900.prt

NOMENCLATURE parameter value would be: GROMMET, PLASTIC, EDGING

PART NUMBER parameter would be: MS21266-2N

DRAWING NUMBER parameter would be: MS21266
If it is used a second time in the same assembly and has a different shape, it would be the same except

the file name would be 19207 12345678-901

F.4 \endor Item Control Drawings

Specification Control drawings now changed to Vendor Item Control Drawing. Parts in this
category generally do not have complete definition of the part required to manufacture the part.
Dimensions that do not appear on the drawing are not checked. If missing dimensions, actual parts
should be obtained and measured to create a model that is representative of the actual part and allow a

drawing to be created that is similar to the original. The part should be weighed and an appropriate

FMTV-MODELING-STD-100T Rev.L Page 164 13 February 2014

Distribution Statement A: Approved for Public Release; Distribution is Unlimited

UNCLASSIFIED



3-Dimensional Technical Data Package Configuration Management,
Modeling, & Drawing Interim Operating Procedure for PdAM-MTV

weight defined in the part. Sectional views that are for general information do not have to be recreated

during the conversion efforts. If there is required information in the section, it still has to be created.

F.5 Source Control Drawings

Similar to Vendor Item Control Drawings as far as modeling is concerned. They will often
have even fewer dimensions. If a model is available from a vendor but does not have all of the
parameters etc. then an assembly should be made using the TV start assembly. All appropriate
parameters etc can then be filled out in the assembly. For Source Control electrical drawings, see

section 7.1.20 for Schematic reference.

F.6 Installation Drawings
In Appendix D.3 of this document, the acceptable methods for creating and working with

lightweight backdrops for installation drawings are described. Using full 3D solid models as
backdrops for installation drawings is not acceptable, regardless of how simple the backdrop objects
are. 3D shrink-wraps are acceptable, which is defined in Appendix D.4. The 2D background geometry
can be created from Creo Parametric models, snapshots, copy geometry, or from imported 2D

geometry.

F.7 AlR ECP parts

Due to the timeframe of the ECP’s as well as the fact that the baseline of the truck has not yet
been released, AL1R parts and drawings are treated a little differently. For checking purposes, three
parameters do not have to be filled out. Drawing Number, Tolerance Angle, and Weight Unit.
‘Background’ or ‘Legacy’ parts are parts that are created to complete an installation, but are not the
released version of the part; do not have to be checked. These parts do not have the cage code
identifier in the front of the file name. They should have an ‘OLD_" at the front to help eliminate the

chance they are used in lieu of the released parts in the future.
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